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All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted 
in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON printer. EPSON is not responsible for any use of this information as applied to other 
printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or 
third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: 
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, 
or (excluding the U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and 
maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original EPSON Products or EPSON 
Approved Products by SEIKO EPSON CORPORATION.

EPSON, EPSON Stylus, and ESC/P are registered trademarks and ESC/P Raster is a trademark of SEIKO 
EPSON CORPORATION. SoundAdvice is a service mark and EPSON FaxAdvice is a trademark of 
Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks 
of their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

Copyright © 1999 by Epson America, Inc. ESP1200199
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Your EPSON Stylus® Photo 1200 printer is the ideal large format output 
device for digital photographs, graphics, layout proofs, and more. With 
resolutions up to 1440 by 720 dpi (dots per inch), six ink colors, and 
EPSON’s award-winning Micro Piezo™ technology, you get amazingly 
realistic photographic images, vivid graphics, and razor-sharp black text.

The printer software for Microsoft® Windows® and Apple® Macintosh® 
provides advanced color management with adjustable brightness, 
contrast, and other settings. For even more precise color matching, use 
ColorSync™ 2.x or one of two Windows color management systems.

EPSON’s specially formulated ink cartridges and wide variety of ink jet 
papers offer the most flexibility for getting the results you want. With 
built-in parallel, serial, and high-speed USB (Universal Serial Bus) ports, 
setting up your printer is fast and easy. 

This chapter gives general printer information in these sections:

◗ Windows System Requirements

◗ Macintosh System Requirements

◗ Printer Parts

◗ How To Use Your Manuals

◗ Energy Star Compliance

◗ Year 2000 Ready

◗ Important Safety Instructions
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To use your printer and its software with a PC, your system should have:

◗ An IBM® compatible PC with at least a 486/25 MHz (for Windows 95 or 
Windows NT® 4.0), or 486/66 MHz (for Windows 98) processor

◗ Microsoft Windows 95, Windows 98, or Windows NT 4.0

◗ At least 16MB of RAM (32MB for Windows 95 or 98 or 64MB for 
Windows NT 4.0 recommended)

◗ At least 50MB of free hard disk space (100MB recommended)

◗ VGA, Super VGA, or better display adapter and monitor

◗ Double-speed (2x) CD-ROM drive—quad-speed (4x) or faster 
recommended—for installing the printer software

◗ For parallel connection, a high-speed, bidirectional, IEEE-1284 
compliant parallel cable (6 to 10 feet long). The cable must have a 
D-SUB, 25-pin, male connector for your computer and a 36-pin, 
Centronics® compatible connector for the printer. 

For USB connection to a computer with Windows 98 and a 
Windows 98 compliant USB port, a shielded USB “AB” interface cable, 
from Series A (computer) to Series B (printer) up to 6.5 ft. (2 meters) 
long.

Using an improperly 
shielded USB cable—
especially a cable 
more than 6.5 ft. 
(2 meters) long—may 
cause the printer to 
malfunction.
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To use your printer and its software with a Macintosh, your system should 
have:

◗ One of the following Macintosh models:

LC475, LC575, LC630
Quadra series
Centris series
PowerBook® series (190, 520, 540, 550 or later)
PowerBook Duo 280, 2300c/100
Performa® 475, 575, 588, 630, 5210 or later
Power Macintosh series
iMac™ Series (for USB connection only)

◗ For serial connection: System 7.5.1 or later (7.6 or later 
recommended)

For USB connection: iMac Series computer with System 8.1 or later

◗ At least 16MB of available RAM 

◗ At least 50MB of free hard disk space (100MB recommended)

◗ RGB display or better

◗ Double-speed (2x) CD-ROM drive—quad-speed (4x) or faster 
recommended—for installing the printer software

◗ For serial connection, an ImageWriter® II serial cable or equivalent 
(8-pin mini DIN male/male, Belkin F2V024 recommended)

For USB connection to an iMac computer, a shielded USB “AB” 
interface cable, from Series A (computer) to Series B (printer) up to 
6.5 ft. (2 meters) long.

Using an improperly 
shielded USB cable—
especially a cable 
more than 6.5 ft. 
(2 meters) long—may 
cause the printer to 
malfunction.
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paper support

printer cover

output tray

output tray extensions

edge 
guides

sheet feeder

paper thickness lever

control panelink cartridge holders
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To set up your printer and install the printer software, see the Start Here 
card. This manual contains the following information:

Basic Printing covers the basics of printing with Windows or Macintosh.

Custom Printing tells you how to print using custom settings for print 
quality, color management, and distinctive layouts.

Printing on Special Papers gives guidelines for selecting the right paper or 
other media for your print job and instructions for loading it in your printer.

Managing Print Jobs explains how to control print jobs and check printer 
status while you’re printing.

Maintenance and Transportation gives instructions for replacing ink 
cartridges, cleaning and aligning the print head, and cleaning and 
transporting the printer.

Troubleshooting provides solutions for problems you may have with your 
printer or software.

Specifications provides the technical details on your printer, ink 
cartridges, and EPSON papers.

To go right to the section you need, see the Index.

����� �����

Maroon, underlined text indicates that the text is a link (cross-reference) 
to other parts of the manual. Click on the text to view the referenced 
information.
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You’ll find this information throughout your manual:

Warnings  must be followed carefully to avoid bodily injury.

Cautions  must be observed to avoid damage to your equipment.

Notes  contain important information about your printer.

Tips contain additional hints for great printing.

������ 	��� ���������

As an ENERGY STAR Partner, EPSON has determined that this product 
meets the ENERGY STAR guidelines for energy efficiency. 

The EPA ENERGY STAR Office Equipment program is a voluntary 
partnership with the computer and office equipment industry to promote 
the introduction of energy-efficient personal computers, monitors, 
printers, fax machines, and copiers in an effort to reduce air pollution 
caused by power generation.
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Your EPSON printer is Year 2000 Ready. However, be sure the other 
parts of your computer system are also ready for the year 2000.

!������� 	�"��
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Before using your printer, read the following safety instructions to make 
sure you use the printer safely and effectively:

◗ Turn off and unplug the printer before cleaning. Clean with a damp 
cloth only. Do not spill liquid on the printer.

◗ Do not place the printer on an unstable surface or near a radiator or 
heating vent.

◗ Do not block or cover the openings in the printer case or insert objects 
through the slots.

◗ Use only the type of power source indicated on the printer’s label.

◗ Connect all equipment to properly grounded power outlets. Avoid 
using outlets on the same circuit as photocopiers or air control systems 
that regularly switch on and off.

◗ Place the printer near a wall outlet where the plug can be easily 
unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche peut être 
débranchée facilement.

◗ Do not let the power cord become damaged or frayed.

Always turn the 
printer off using the 
P power button. 
Don’t switch off the 
power strip or unplug 
the printer until the 
P power light is off.
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◗ If you use an extension cord with the printer, make sure the total 
ampere rating of the devices plugged into the extension cord does not 
exceed the cord’s ampere rating. Also, make sure the total ampere 
rating of all devices plugged into the wall outlet does not exceed the 
wall outlet’s ampere rating.

◗ Except as specifically explained in this manual, do not attempt to 
service the printer yourself.

◗ Unplug the printer and refer servicing to qualified service personnel 
under the following conditions: 

If the power cord or plug is damaged; if liquid has entered the printer; 
if the printer has been dropped or the cabinet damaged; if the printer 
does not operate normally or exhibits a distinct change in performance. 
Adjust only those controls that are covered by the operating 
instructions.

◗ Do not put your hand inside the printer or touch the cartridge during 
printing.

◗ Under normal circumstances, ink will not come out of the cartridge. If it 
does get on your skin, wash it off with soap and water. If it gets in your 
eyes, flush them immediately with water.

◗ Keep ink cartridges out of the reach of children.

◗ Do not dismantle the ink cartridges or try to refill them. This could 
result in damage to the print head.

◗ Once you install an ink cartridge, do not open the clamp or remove the 
cartridge except to replace it with a new one. The cartridge may 
become unusable otherwise.
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◗ Install the ink cartridge immediately after you remove it from its foil 
package. Leaving the cartridge unpacked for a long time before use 
may result in reduced print quality.

◗ Do not use an ink cartridge beyond the date printed on the cartridge 
package. For best results, use up the ink cartridges within six months 
of installing them.

◗ Do not shake an ink cartridge; this can cause leakage.

◗ Always turn the printer off using the 

 

Ppower button. When you press 
this button, the 

 

Ppower light flashes briefly then goes out. Do not 
unplug the printer or turn off power to the printer until the 

 

Ppower light 
is off.

◗ Before transporting the printer, make sure the print head is positioned 
all the way to the right (capped) and the ink cartridges are in place.
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It’s easy to print all your documents with your EPSON Stylus Photo 1200. 
First set up your printer and install the software, following the instructions 
in the Start Here card. Read this chapter to find out about:

◗ Printing from Windows

◗ Printing from a Macintosh

�������# "�� �������

This section tells you about:

◗ Printing from Windows Applications

◗ Setting Default Printer Options

◗ Checking Printer Status
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This section describes the settings you’ll need to check for all your 
everyday printouts. See Custom Printing for information about advanced 
settings for special print jobs. 

1 Open a Windows application and select a file you want to print.

2 Open the File menu and click Print . You see a Print dialog box such as 
this (depending on your application):

3 Make sure your EPSON Stylus Photo 1200 printer is selected, and 
then click the Properties  button. (If you see a Setup, Printer, or 
Options button, click it instead. Then click Properties  on the next 
screen.)

You can also set 
printer options by 
clicking Print Setup  
or Page Setup  in 
the File menu, then 
clicking the 
Properties  button. 
However, in most 
applications you’ll 
then have to select a 
separate Print option 
or icon to print using 
your changes.

Click Properties
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You see the printer settings dialog box:

4 Click the Main  tab if necessary. Then choose the Media Type  you 
want to print on from the following list:

◗ Plain paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

◗ Ink Jet Back Light Film

Click to select 
your paper type

Click for more 
information

Use the 
Quality/Speed 
slider to select 
your print 
resolution

Click to select 
Automatic mode

To print at the highest 
resolution (1440 dpi), 
you need to use plain 
paper, Photo Paper, 
one of the Photo 
Quality papers, or Ink 
Jet Back Light Film. 
For the best printing at 
any resolution, always 
use EPSON papers.
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The type of paper you choose determines the print quality (resolution) 
you can use. It’s very important to select the correct setting for your 
paper. If you’re not sure which to choose, see Selecting the Right 
Settings for Your Paper.

5 Choose Color  or Black  ink.

6 Now make sure the Mode option is set to Automatic . This is the 
easiest way to get good printing results for all kinds of documents, on 
all types of paper.

7 Set the slider to Quality  or Speed . This lets you choose between the 
fastest printing or a high resolution for the paper you’re using. 

To select 1440 dpi or any other available resolution for your paper, you 
need to access the Advanced dialog box; see Customizing Print 
Quality and Special Effects for instructions.

8 Click the Paper  tab and choose your paper size, paper source, 
number of copies, orientation, and printable area settings. See 
Selecting Paper Options in Windows for instructions. 

9 Click the Layout  tab and check the reduce/enlarge, page layout, and 
watermark settings. See Choosing Print Layout Options in Windows 
for details.

10 Click OK  when you’re finished checking your settings. The dialog box 
closes. Click OK  until you see the Print dialog box.

11 In the Print dialog box, click OK  or Print . 

While your document is printing, a window appears showing the printer 
status and the progress of your print job. See Checking Printer Status 
for more information.

The Quality/Speed 
slider is not available 
for certain paper 
types. 
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When you change printer settings through your software application, the 
settings apply only to the application you’re using. To adjust the default 
settings for all your Windows applications, access your printer software 
through the Windows Printers utility. Close all your applications before 
you start. If you don’t, you may have to close and reopen them to use the 
new default settings.

1 Click Start , point to Settings , and select Printers . 

2 Right-click the EPSON Stylus Photo 1200  icon. 

3 Select Properties  or Document Defaults  (Windows NT), then click 
the Main  tab. You see the printer settings dialog box shown under 
Printing from Windows Applications with some additional tabs at the 
top. 

4 Change your settings as necessary. Then click OK to save the new 
settings as your Windows default settings.

You can access the 
default Windows NT 
printer software 
settings only if you 
have the appropriate 
network access 
privileges, such as 
Administrator.
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After you send a print job, the Progress Meter window appears on your 
screen to report how the job is doing:

The Progress Meter shows the progress of your print job and the status of 
your printer. You can use the buttons to cancel, pause, or restart your 
print job. 

If you installed Status Monitor 2, you also see information about how 
much ink you have left and can view the Status Monitor 2 Printer Status 
window. See Using Status Monitor 2 for more information.

You can also set up the way your printer software sends print jobs and 
select whether or not to display the Progress Meter; see Optimizing Data 
Transfer and Displaying the Progress Meter for instructions.

Click to pause 

Click to cancel 

Click to restart 

Click to view the Status 
Monitor 2 Printer Status 
window

This information 
appears only if 
you installed 
Status Monitor 2 
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When you print with a Macintosh, you need to check the printer software 
settings in each application you use. This section describes the settings 
you’ll need to check for all your everyday printouts. See Custom Printing 
for information about advanced settings for special print jobs. 

Follow these steps to print from a Macintosh:

1 Open a Macintosh application and select a file you want to print.

2 Open the File menu and click Page Setup  (Document Setup  in some 
applications). You see the Page Setup dialog box:

3 Choose your paper size, paper source, orientation, and other options 
as described in Selecting Paper Options on a Macintosh and click OK. 

4 Now open the File menu and click Print . 

On the Macintosh, 
printer settings are 
saved with your 
document, but not 
from one application 
to another. If you 
want to reuse 
settings, you can 
create document 
templates for your 
favorite applications.

You can also create 
custom setting groups 
in your printer 
software that you can 
select each time you 
open an application. 
See Saving Custom 
Settings for details.
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You see the main printer settings dialog box:

5 Choose the number of copies and indicate which pages you want 
to print.

6 Choose the Media Type  you want to print on from the following list:

◗ Plain Paper

◗ 360 dpi Ink Jet Paper 

◗ Photo Quality Ink Jet Paper

◗ Photo Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

◗ Ink Jet Back Light Film

The type of paper you choose determines the print quality you can use. 
It’s very important to select the correct Media Type setting for your 
paper. If you’re not sure which to choose, see Selecting the Right 
Settings for Your Paper.

Click to select 
your paper 
type

Use the 
Quality/Speed 
slider to select 
your print 
resolution

Click to 
select 
Automatic 
mode

Select All  or 
enter a range 
of pages to 
print

To print at the highest 
resolution (1440 dpi), 
you need to use plain 
paper, Photo Paper, 
one of the Photo 
Quality papers, or Ink 
Jet Back Light Film. 
For the best printing at 
any resolution, always 
use EPSON paper.
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7 Choose Color  or Black ink.

8 Make sure the Mode option is set to Automatic . This is the easiest 
way to get good printing results for all kinds of documents, on all types 
of paper.

9 Set the slider to Quality  or Speed . This lets you choose between the 
fastest printing or a high resolution for the paper you’re using. To 
select 1440 dpi or any other available resolution for your paper, you 
need to access the Advanced dialog box; see Customizing Print 
Quality and Special Effects for instructions.

10 Click the Layout icon and check the fit to page, watermark, page 
layout, and print order settings. See Choosing Print Layout Options on 
a Macintosh and Selecting Print Order Options for details. Then click 
OK  to return to the printer settings dialog box.

11 Background printing lets you continue working while your document 
prints. To select background printing options before you print, click the 

Background Printing icon. See Using Background Printing on the 
Macintosh for details.

12 If you want to preview your printout to view how the current layout, 
watermark, print order, and orientation settings look, click the 

Preview icon, then click the Preview  button. See Using Print 
Preview on the Macintosh for details.

13 Click Print when you’re finished checking your settings. 

If you turned on background printing, you can continue working while 
your document is printing. While printing, a window appears showing 
the printer status and the progress of your print job. See Checking 
Printer Status for details.

The Quality/Speed 
slider is not available 
for certain paper 
types. 
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If you turned on background printing, EPSON Monitor3 automatically 
displays this dialog box when you send a print job to the printer:

You can use the Monitor3 dialog box to check on your print jobs and 
cancel, pause, or restart them.

The progress bar tracks the progress of the current print job. To pause, 
cancel, or restart a print job (either the current one or any job waiting to 
print), click the document’s name to highlight it. Then click one of the 
following buttons: 

◗ click  to cancel 

◗ click  to pause

◗ click  to restart 

See Using Monitor3 for details on all the EPSON Monitor3 features.

Current print 
job

Jobs waiting 
to print

Click to set 
priorities or print 
times for waiting 
print jobs

Progress bar

When background 
printing is turned off, 
you can cancel your 
print job by pressing 
the  and . (period) 
keys.
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When your presentation graphics, photographs, or other projects have 
special printing requirements, you can use the custom settings in your 
EPSON Stylus Photo 1200 software. You can choose custom project 
types or adjust individual settings like brightness, contrast, sharpness, 
and halftoning. For professional-quality color accuracy, you can use a 
color matching mode.

Your printer software’s print layout options let you print almost any size 
image on your printer, proof multiple pages on one sheet of paper, and 
add watermarks.

This chapter includes the following information:

◗ Using Custom Project Types

◗ Customizing Print Quality and Special Effects

◗ Customizing Color Settings

◗ Using ColorSync on the Macintosh

◗ Selecting Paper Size and Orientation Options

◗ Selecting Print Layout Options

◗ Using Print Preview on the Macintosh

◗ Using Background Printing on the Macintosh

◗ Saving Custom Settings
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Custom project types provide an easy way to fine-tune your printer 
settings for a specific type of project. Follow these steps to print with 
custom project types:

1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing from 
Windows or Printing from a Macintosh. You see one of the following:

3 Choose the Media Type  you want to print on. (If you’re not sure which 
setting to choose, see Selecting the Right Settings for Your Paper.)

4 Choose Color  or Black  ink.

Windows

Click Custom , then click here to see a list of project types

Macintosh
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5 Click Custom , then click Custom Settings . You see a list of project 
types.

6 Choose the right setting for your project and Media Type, following 
these guidelines:

◗ PhotoEnhance3  
For printing images captured using a video camera, digital camera, 
or scanner. Produces sharper images and more vivid colors by 
automatically adjusting the contrast, saturation, and brightness. 
Corrects for overall under- or over-exposure of the original image.

◗ Digital Camera
For printing images captured using a scanner or digital camera. 
Corrects noise and other common flaws.

◗ Text/Graph
For printing graphics-intensive documents like presentation pages 
with charts and graphs. Intensifies colors and lightens the midtones 
and highlights.

◗ Text
For fast printing of text-only documents on plain paper.

◗ Economy
For rough drafts of text on plain paper. Saves ink. 

◗ ICM (Image Color Matching; Windows 95 and Windows 98 only)
For printing documents created in an ICM compatible application. If 
you’re using an ICM compatible monitor, adjusts printed colors to 
closely match the screen colors. 

Always choose your 
Media Type and Ink 
setting before you 
select a custom 
project type. Some 
project types may not 
be available with the 
Media Type or Ink 
settings you choose.

Printing using 
PhotoEnhance3 may 
take longer with some 
systems and images.

Don’t select 
PhotoEnhance3 
when you’re printing 
on Banner Photo 
Paper.
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◗ sRGB  (standard Red Green Blue; recommended only with 
Windows 98)
For printing documents created in an sRGB compatible application 
using sRGB colors, such as those designed for the World Wide 
Web. Before using this setting, set up your sRGB compatible 
devices (such as your monitor and printer) to use an sRGB color 
profile; see your Windows 98 online help for details.

◗ ColorSync  (Macintosh only)
Automatically adjusts printout colors to closely match the colors on 
your screen. For more information, see Using ColorSync on the 
Macintosh.

7 In Windows, click the Paper  and Layout  tabs to check or change any 
necessary settings, as described in Selecting Paper Options in 
Windows and Choosing Print Layout Options in Windows. 

On a Macintosh, check or change any necessary settings on the Page 
Setup and the Layout dialog boxes as described in Selecting Paper 
Options on a Macintosh and Choosing Print Layout Options on a 
Macintosh.

8 When you’re finished, click OK (Windows) or Print (Macintosh). Click 
any other buttons that your application uses for printing, if necessary.
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If you need the maximum control over your project, or you want to 
experiment with special effects, you can adjust the custom settings in 
your printer software. Follow these steps:

1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing from 
Windows or Printing from a Macintosh.

3 Click Custom,  and then click the Advanced button. You see the 
Advanced dialog box:

After you customize 
your print settings for 
a special project, you 
can save them as a 
group. Then you can 
reuse them whenever 
you print a similar 
project. See Saving 
Custom Settings for 
instructions.

Windows 

Click here to change 
your Print Quality 
(resolution)

Some of these 
options are 
automatically set 
or disabled by other 
settings you choose
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4 Choose the Media Type  and Ink  settings you want to use, following 
the guidelines in Printing from Windows and Printing from a Macintosh. 

5 Choose one of the following Print Quality options:

◗ Economy
For low-resolution rough drafts on plain paper. Saves ink.

◗ Normal - 360 dpi
For most documents on plain paper, transparencies, or 360 dpi Ink 
Jet Paper.

◗ Fine - 720 dpi
For high-resolution output on Photo Paper or Photo Quality Ink Jet 
Paper. Recommended for printing graphics and solid areas of color.

◗ Photo - 720 dpi
For high-resolution output on plain paper, Photo Paper, Photo 
Quality papers, or Back Light Film. Recommended for delicate 
shading of lighter colors.

Macintosh

Some of these options 
are automatically set or 
disabled by other 
settings you choose

Click here to change your 
Print Quality (resolution)

The available Print 
Quality settings may 
be limited by the 
Media Type you 
choose.
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◗ Photo - 1440 dpi
For the highest-resolution output on plain paper, Photo Paper, 
Photo Quality papers, or Back Light Film.

6 Choose one of the following Halftoning  options:

◗ Error Diffusion
For printing photographic images. Blends each color dot with the 
dots around it.

◗ Fine Dithering
For printing graphs or other images that require precise, solid areas 
of bright colors. 

7 Choose any of the following print options: 

◗ MicroWeave
For improved print quality. Prints graphic data in finer increments to 
eliminate unwanted banding (light horizontal lines). Always use for 
color printing.

◗ High Speed
For fast, bidirectional printing at lower quality. If vertical lines in your 
printout are misaligned when you use the High Speed setting, you 
may need to turn it off or align the print head; see Aligning the Print 
Head for instructions.

◗ Flip Horizontal
For printing a mirror image of your document. Use with iron-on 
transfer paper so your ironed-on printout will read correctly.

◗ Finest Detail
For printing text, graphics, and line art with very sharp edges. Slows 
print speed and increases your system memory requirements. 

In Automatic mode, 
the Halftoning setting 
is selected based on 
the data in your print 
job. In Custom mode, 
Halftoning is 
preselected for each 
project type setting. 

Some of the print 
option checkboxes in 
the Advanced dialog 
box are automatically 
selected or disabled 
by the Print Quality 
(resolution) you 
choose.
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8 Click OK  if you’re ready to return to the printer settings dialog box, or 
see Customizing Color Settings if you want to adjust your document’s 
color settings.
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There are three ways to manage the color in your documents using your 
printer software:

◗ Using PhotoEnhance3 and Digital Camera Correction to automatically 
correct digital photographs for exposure and other common flaws, and 
to adjust the tone or sharpness

◗ Using Custom Color Adjustment to select individual color values to 
fine-tune the color in text, graphics, or economy mode documents

◗ Using a Color Correction System to match the printed output to your 
on-screen colors

The appearance of the Color Management section of the Advanced 
dialog box changes, depending on the settings you’ve selected.
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To correct the exposure, tone, and sharpness of digital images, you can 
use PhotoEnhance3 and/or Digital Camera Correction.

1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing from 
Windows or Printing from a Macintosh.
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3 Click Custom,  then select either PhotoEnhance3  or Digital Camera  
as described in Using Custom Project Types.

4 Click the Advanced button. The Color Management section of the 
Advanced dialog box appears as shown here:

5 You can customize your image using these settings:

◗ Select a Tone setting for your image: Normal  for standard tones, 
Hard  for high contrast, or Sepia  for an old-fashioned photo look.

◗ Turn on Digital Camera Correction  to correct noise and other 
flaws common to digital camera images.

◗ Select Sharpness  to sharpen the image, especially the edges.

6 Click OK  to return to the printer settings dialog box.

The Color 
Management section 
also changes to this 
view if you select the 
PhotoEnhance3 radio 
button in the 
Advanced dialog box. 

Don’t select 
PhotoEnhance3 
when you’re printing 
on Banner Photo 
Paper.

Windows Macintosh

Click to select a 
Tone setting, if 
necessary. 
Changes appear 
in the example 
photograph.

Click to turn on 
Digital Camera 
Correction 
and/or sharpen 
the image.
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You can choose from several custom Color Adjustment modes or 
manually adjust brightness, contrast, saturation, and CMY (cyan, 
magenta, yellow) color values.

1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing from 
Windows or Printing from a Macintosh.

3 Click Custom,  then either select Text/Graph , Text , or Economy  as 
described in Using Custom Project Types, or don’t select any custom 
project type. 

4 Click the Advanced button. The Color Management section of the 
Advanced dialog box appears as shown here:

Click the Color 
Adjustment radio 
button if you don’t 
see this view.

Windows
Macintosh

Not available 
with 
Windows NT



������ ������ ���� ��

5 Choose one of the following Color Adjustment  modes: 

◗ Automatic
Analyzes the color information in your project and optimizes color 
correction accordingly.

◗ Photo-realistic
For printing color photographs. 

◗ Vivid
For printing graphics-intensive documents like presentations with 
graphs. Intensifies colors and lightens the midtones and highlights. 

◗ No Color Adjustment  
Disables the color adjustment features of the printer software so 
you can use other color management software. 

6 If you want to specify individual color correction values, use the sliders 
to increase (drag right) or decrease (drag left) the settings listed below. 

◗ Brightness
Makes your image lighter or darker.

◗ Contrast
Increases or decreases the difference between the light and dark 
parts of an image.

◗ Saturation
Makes colors more vivid or less vivid.

◗ Cyan, Magenta, Yellow
Increases or decreases the amount of the three main ink colors that 
combine to make a full-color printout. The Cyan and Magenta 
settings also affect the light cyan and light magenta inks.

7 Click OK  to return to the printer settings dialog box.
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To achieve the maximum color accuracy, you can use Image Color 
Matching (ICM; Windows 95 and 98 only), standard Red Green Blue 
(sRGB; recommended only with Windows 98), or ColorSync (Macintosh 
only), if your system is set up to use them.

1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing from 
Windows or Printing from a Macintosh.

3 Click Custom,  then select either ICM (Windows 95 or 98 only), sRGB  
(recommended only with Windows 98), or ColorSync  (Macintosh only) 
as described in Using Custom Project Types.

4 Click the Advanced button. The Color Management section of the 
Advanced dialog box appears as shown here:

The Color 
Management section 
also changes to this 
view if you select the 
ICM, sRGB , or 
ColorSync  radio 
button in the 
Advanced dialog box. Windows Macintosh

Not available 
with 
Windows NT

For details, 
see Using 
ColorSync 
on the 
Macintosh
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5 Select one of these color correction systems:

◗ ICM (Image Color Matching; Windows 95 and Windows 98 only)
For printing documents created in an ICM compatible application. If 
you’re using an ICM compatible monitor, adjusts printed colors to 
closely match the screen colors. 

◗ sRGB  (standard Red Green Blue; recommended only with 
Windows 98)
For printing documents created in an sRGB compatible application 
using sRGB colors, such as those designed for the World Wide 
Web. Before using this setting, set up your sRGB compatible 
devices (such as your monitor and printer) to use an sRGB color 
profile; see your Windows 98 online help for details.

◗ ColorSync  (Macintosh only)
Automatically adjusts printout colors to match colors on the screen. 
See Using ColorSync on the Macintosh for more information.

6 Click OK  to return to the printer settings dialog box.
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Every device you use for producing or viewing colors—your monitor, 
scanner, and printer—employs a different color technology. The 
Macintosh ColorSync system helps you control all your devices so their 
colors match your printer’s as closely as possible. 
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ColorSync uses profile information from each device—including your 
EPSON Stylus Photo 1200 printer—to achieve accurate color matching. 
First you have to make sure your monitor’s profile is set. Then you can 
use your printer software to specify the exact method of color matching 
you want to use.

Follow the steps below to set your monitor’s ColorSync profile and use 
your printer software’s ColorSync features. The steps may be different, or 
there may be additional steps, depending on your Macintosh OS version; 
see your Macintosh documentation for more information on setting up 
ColorSync.

1 Open the ColorSync System Profile  under Control Panels  on the 
Apple menu.

2 Click the Set Profile  button.

3 Select your monitor from the list, and then click Select .

4 Close ColorSync System Profile.

5 Open an application and select a document to print.

6 Open the File menu and click Print .

7 Click Custom , then click Advanced . You see the Advanced dialog 
box.

8 Click the ColorSync  radio button.

9 For Profile , choose EPSON Standard . This is the ColorSync profile 
created especially for your printer. Don’t choose any other printer 
profile you may have on your system.

When you install your 
printer software, you 
automatically install 
the ColorSync profile 
for your printer. If 
your system doesn’t 
have ColorSync, the 
installer also 
automatically installs 
ColorSync 2.0. If you 
already have 
ColorSync 2.0 or a 
later version, the 
installer doesn’t 
install ColorSync.
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10 Choose one of the following options for Rendering Intent :

◗ Perceptual
For printing scanned photographs. Maintains the relationship 
between colors as it scales them to fit within your printer’s color 
gamut.

◗ Saturation
For printing graphics-intensive documents like presentation pages 
with charts and graphs. Maintains the relative saturation of colors 
from one gamut to another.

◗ Colorimetric
For all other document types. Maintains colors that fall within the 
gamut of both your monitor and printer.

11 Click OK  to return to the printer settings dialog box.
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Your printer can print on paper up to 12.95 inches wide and up to 
44 inches long in either portrait or landscape orientation. If you print 
multi-page documents or multiple copies of documents, you can print the 
pages collated and in reverse order. You can even rotate the printed 
document by 180 degrees to make it closer to the bottom of the paper.

Follow the steps in the section for your operating system:

◗ Selecting Paper Options in Windows

◗ Selecting Paper Options on a Macintosh

The Rendering Intent 
options may be 
limited by the Media 
Type you’ve selected.
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Follow these steps to select paper options on the Paper tab:

1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing from 
Windows.

3 Click the Paper  tab. You see the Paper dialog box:

Click to select 
your Paper Size 

Printer graphic 
reflects changes 
to Orientation 
and Printable Area 
settings

Page graphics 
change to show 
Collate and 
Reverse Order 
settings
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4 Click the Paper Size drop-down list to select the size of paper you 
loaded in the printer. 

The sizes marked with an asterisk (*) are larger than you can load in 
the printer and can be used only with the Reduce/Enlarge  setting on 
the Layout tab; see Reducing and Enlarging Your Document Size for 
more information.

5 If you loaded Photo Paper that you cut from a roll, select Banner  as 
the Paper Source setting. See EPSON Banner Photo Paper for 
instructions on preparing and loading roll paper. With Banner selected, 
you can’t change the Collate, Reverse Order, Rotate by 180,° or 
Printable Area settings, or any Layout settings.

A4 210  × 297 mm
A5 148  × 210 mm
A3 297  × 420 mm
Super A3/B 329  × 483 mm
B5 182  × 257 mm
B4 257  × 364 mm
US B 11  × 17 in
Letter 8 1/2  × 11 in
Legal 8 1/2  × 14 in
Executive 7 1/4  × 10 1/2 in
Half Letter 5 1/2  × 8 1/2 in
A6 Index card 105  × 148 mm
Index card 5  × 8 in

Index card 8  × 10 in
Envelope #10 4 1/8  × 9 1/2 in
Envelope DL 110  × 220 mm
Envelope C6 114  × 162 mm
Envelope 132  × 220 mm
Photo Paper 4  × 6 in
Panoramic 210  × 594 mm
B3 364  × 514 mm *
A2 420  × 594 mm *
US C 17 × 22 in *
User Defined  (See Creating 
User Defined Paper Sizes for 
instructions.)

If the Reduce/Enlarge 
setting is set to 
Normal and you 
select one of the 
paper sizes to the 
right that is marked 
with an asterisk (*), 
you see a dialog box 
asking you to select a 
paper size that fits 
your printer. See 
Reducing and 
Enlarging Your 
Document Size for 
more information.
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6 If you did not or cannot select the number of copies you want to print in 
your application program’s Print dialog box, choose the number in the 
Copies box. Don’t select the number of copies here and in your 
application’s Print dialog box; you may get twice the number of copies 
you want.

7 If you’re printing multiple copies of a multi-page document and you 
want the copies printed in sets, click the Collate  checkbox. The page 
graphics change to show collated documents.

8 If you’re printing a multi-page document and want the last page printed 
first so the pages come out without needing to be reordered, click the 
Reverse Order  checkbox. The page graphics change to show later 
pages printing first.

9 Select the direction of printing on the page with the Orientation options. 
To print your document oriented as shown in one of the following 
illustrations, select the options listed below it.

The Rotate by 180° 
setting lets you print 
the lower portion of a 
document first, with a 
bottom margin as 
small as 0.12 inch 
(3 mm) and a top 
margin as small as 
0.55 inch (14 mm). 

Portrait Landscape Portrait and 
Rotate by 180°

Landscape and 
Rotate by 180°
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10 The Standard Printable Area setting uses the maximum printable area 
of your paper with a minimum bottom margin of 0.55 inch (14 mm). To 
decrease the minimum bottom margin to 0.12 inch (3 mm), set the 
Printable Area setting to Maximum . To center your document on the 
page using either setting, select the Centered  checkbox.

11 Click a tab for the settings you want to check or change next, or click 
OK  to print your document.
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You can create up to 10 custom paper sizes and add them to the Paper 
Size list using the User Defined option. This is useful if you’re printing a 
custom size document, such as a banner. You can select any width from 
3.5 to 12.95 inches, and any height (length) from 3.5 to 44 inches.

Follow these steps to create a User Defined paper size:

1 Follow the steps in Printing from Windows to access the printer 
software, then click the Paper  tab.

2 Click the Paper Size  list and scroll to the bottom of it using the arrows 
or scroll bar. 

3 Click the User Defined  option. You see the following dialog box:

When you select 
Maximum as the 
Printable Area 
setting, print quality 
may decrease in the 
expanded printable 
area in the bottom 
margin.

Don’t select 
Maximum as the 
Printable Area setting 
if you’re printing on 
EPSON Ink Jet Back 
Light Film.
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4 Type a name (up to 24 characters) for your custom paper size in the 
Paper Size Name field. Then select a Paper Width  and Paper Height  
for the paper. To use centimeters instead of inches, click the 0.01cm  
option. When you’re finished, click Save. The paper size name 
appears in the Paper Size list in the dialog box. Add more sizes if you 
want, and click OK  when you’re done.

5 You see the Paper tab again. The paper size name you defined is 
added to the Paper Size list and selected as the current setting. 

6 Click a tab for the settings you want to check or change next, or click 
OK  to print your document.
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1 Click User Defined  in the Paper Size list. 

2 In the User Defined Paper Size dialog box, select the custom paper 
name in the Paper Size list and change the Paper Width , Paper 
Height , and Unit  settings as necessary, or click Delete . 

3 Click OK  when you’re done.
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The Paper Size and Orientation options for your printer software are on 
the Page Setup dialog box. The options for collating and reversing the 
page order are on the Layout dialog box. Follow the steps in these 
sections for selecting the paper options:

◗ Choosing Paper Size and Orientation Options

◗ Selecting Print Order Options

The Paper Width and 
Paper Height units 
are in hundredth of an 
inch (or centimeter) 
increments. For 
example, 850 equals 
8.50 inches.
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Follow these steps to select the Paper Size and Orientation:

1 Create your image or document in your application software.

2 Open the File menu and select Page Setup . You see the Page Setup 
dialog box:

3 Click the Paper Size pop-up list to select the size of paper you loaded. 

If you don’t see the exact size you need, you can create a custom 
paper size; see Creating Custom Paper Sizes.

Paper Size 
Printer graphic 
reflects changes 
to Orientation and 
Printable Area 
settings

Click to select your
Orientation options

Click to select 
your Printable 
Area options

Paper Source 

A4 (210  × 297 mm)
A5 (148  × 210 mm)
A3 (297  × 420 mm)
Super A3/B (329  × 483 mm)
B5 (182  × 257 mm)
B4 (257  × 364 mm)
US B (11 × 17 in)
Letter (8 1/2  × 11 in)
Legal (8 1/2  × 14 in)
Executive (7 1/4  × 10 1/2 in)

Half Letter (5 1/2  × 8 1/2 in)
A6 Index card (105  × 148 mm)
Index card 5  × 8 in
Index card 8  × 10 in
Envelope #10 (4 1/8  × 9 1/2 in)
Envelope DL (110  × 220 mm)
Envelope C6 (114  × 162 mm)
Envelope 132  × 220 mm
EPSON Photo Paper 4  × 6 in
Panoramic 210  × 594 mm
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4 If you loaded Photo Paper that you cut from a roll, select Banner  as 
the Paper Source setting. See EPSON Banner Photo Paper for 
instructions on preparing and loading roll paper. With Banner selected, 
you can’t change the Collate, Reverse Order, Rotate by 180,° or 
Printable Area settings, or any Layout settings.

5 Select the direction of printing on the page with the Orientation options. 
To print your document oriented as shown in one of the following 
illustrations, select the options listed below it.

6 The Standard Printable Area setting uses the maximum printable area 
of your paper with a minimum bottom margin of 0.55 inch (14 mm). To 
decrease the minimum bottom margin to 0.12 inch (3 mm), set the 
Printable Area setting to Maximum . To center your document on the 
page using either setting, select the Centered  checkbox.

7 To collate multiple copies of a multi-page document or reverse the 
order in which pages are printed, see Selecting Print Order Options. 

The Rotate by 180° 
setting lets you print 
the lower portion of a 
document first, with a 
bottom margin as 
small as 0.12 inch 
(3 mm) and a top 
margin as small as 
0.55 inch (14 mm).

When you select 
Maximum as the 
Printable Area 
setting, print quality 
may decrease in the 
expanded printable 
area in the bottom 
margin.

Don’t select 
Maximum as the 
Printable Area setting 
if you’re printing on 
EPSON Ink Jet Back 
Light Film.

Portrait Landscape Portrait and 
Rotate by 180°

Landscape and 
Rotate by 180°
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If you’ve finished selecting options, click OK to close the Page Setup 
dialog box. Then select Print  from the File menu to print your 
document.
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You can create up to 8 custom paper sizes and add them to the Paper 
Size list. This is useful if you’re printing a custom size document, such as 
a banner. You can select any width from 3.5 to 12.95 inches, and any 
height (length) from 3.5 to 44 inches.

1 Open your application’s File menu and select Page Setup .

2 Click the Customize  button. You see the following dialog box:

3 Click the New button. Width  and Height  fields and Inches  and cm  
radio buttons appear on the screen.

4 Type the width and length of your custom paper in the Width  and 
Height  fields. If you need to change from inches to centimeters, click 
the cm  radio button.

To delete a custom 
paper size, click the 
Customize  button. 
Then click the name 
of the custom paper 
size and click Delete .
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5 Type a name for your paper size in the New Paper Size  field, then 
click OK. The name is added to the Paper Size list and selected as the 
current setting in the Page Setup dialog box. 

6 Click OK  to return to the Page Setup dialog box.
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Follow these steps to use the Collate and Reverse Order options:

1 Open your application program’s File menu and select Print .

2 Click the Layout icon. You see the Layout dialog box:

3 If you’re printing multiple copies of a multi-page document and you 
want the copies printed in sets, click the Collate  checkbox. The page 
graphics change to show collated documents.

For information on the 
other settings on the 
Layout dialog box, 
see Choosing Print 
Layout Options on a 
Macintosh.

Print Order options
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4 If you’re printing a multi-page document and want the last page printed 
first so the pages come out without needing to be reordered, click the 
Reverse Order  checkbox. The page graphics change to show later 
pages printing first.

5 Click OK  to close the Layout dialog box.
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The print layout options let you reduce or enlarge almost any size 
document to print on your printer. You can also select options to proof 
multiple pages on one sheet of paper, add page frames, and add a 
predefined or custom watermark.

Follow the steps in the section for your operating system:

◗ Choosing Print Layout Options in Windows

◗ Choosing Print Layout Options on a Macintosh
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Follow the steps in these sections to use options in the Layout dialog box:

◗ Reducing and Enlarging Your Document Size

◗ Using Multiple Page Layouts and Page Frames

◗ Adding a Watermark

If you selected 
Banner  as the Paper 
Source option, you 
can’t change any 
Print Layout settings. 
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When you want to make the printed size of a document different from its 
original size, you can use your printer software’s Reduce/Enlarge 
settings. You can make the document fit into the printable area on a 
selected paper size or you can choose to reduce or enlarge it to a 
selected percentage of its original size.

Follow these steps to reduce or enlarge your document size:

1 Create your document in your application software.

2 Follow the steps in Printing from Windows to access the printer 
settings dialog box, then click the Paper  tab.

3 Click the Paper Size  list and select your document’s size as 
determined by your application. 

4 If the Paper Size setting you selected is within the maximum paper 
size that can fit on your printer, but you want to enlarge or reduce the 
document, go to step 5.

If the Paper Size setting you selected is larger than the maximum size 
that can be printed on your printer, you see the following dialog box:

Output Paper 
list
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In the Output Paper list, select the actual size of the paper loaded in 
the printer and click OK. This automatically turns on the Fit to Page 
setting so the document fits into the printable area on the output paper 
you select. The selected Paper Size, reduction percentage, and 
Output Paper settings now appear above the printer graphic.

If you want to adjust the proportions or sizes further, go to step 5. If 
you’re ready to print, go to step 7.

5 Click the Layout  tab. You see the Layout dialog box:

Paper Size setting

reduction 
percentage

Output Paper 
setting

Reduce/Enlarge 
settings
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6 Select one of the following Reduce/Enlarge settings:

◗ Select Normal  to set the print proportion to 100%. 

◗ Select Fit to Page  to automatically reduce or enlarge the document 
to fit on the paper size loaded in the printer. The Paper Size option 
beneath the Fit to Page setting becomes active; if necessary, select 
the size of paper loaded in the printer.

◗ Select Custom , then select a percentage (10% to 400%) in the 
Scale to  field to reduce or enlarge the document by a specific 
amount.

7 If you’re finished selecting Layout options, click OK.

If you want to select more options, see Using Multiple Page Layouts 
and Page Frames and Adding a Watermark.

If you previously 
selected a Paper Size 
setting that is larger 
than the maximum 
paper size for your 
printer and then 
choose Normal , the 
Paper Size changes to 
Letter 8 1/2 × 11 in.

Select Fit to Page , 
then select the size 
of paper loaded in 
the printer 
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If you’re printing a multiple page document and want a quick proof of each 
page printed on one piece of paper, you can select a page layout option in 
the printer software. You can choose the way the pages are placed on the 
paper and add a lined frame to each page, if you want.

Follow these steps to use the page layout options:

1 Follow the steps in Printing from Windows to access the printer 
settings dialog box. 

2 Click the Layout  tab. You see the Layout dialog box.

3 To print multiple pages of your document on one sheet of paper, select 
either the 2 Pages  or 4 Pages  radio button.

4 The layout of the on-screen graphic shows the page order of how your 
document will print. To change the page order, click the Page Order  
button. Then select the page order you want to use from the Print 
Layout dialog box that appears.

5 If you want to frame each page’s contents with a thin black line, click 
the Print page frames  checkbox.

6 If you’re finished selecting Layout options, click OK. If you want to 
select more options, see Adding a Watermark.

Click a button to 
select a multiple 
page layout
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You can add a watermark to each page in your document to emphasize 
its purpose or indicate how it should be handled. For example, you may 
want to add a watermark of the word “Confidential” to documents you 
don’t want distributed to other parties. Or you can add a custom bitmap of 
your company logo so your document looks like printed letterhead.

Follow these steps to add a watermark:

1 Follow the steps in Printing from Windows to access the printer 
settings dialog box. 

2 Click the Layout  tab. You see the Layout dialog box.

3 To select a watermark, click the Watermark drop-down list.

Then highlight one of the following watermarks:

To turn off your watermark, select None  from the drop-down list.

Confidential
Draft
Urgent
Priority
Hot

Do Not Copy
For Your Eyes Only
Review Copy
Top Secret
Duplicate

To add a custom 
watermark, you must 
first create the 
watermark as a bitmap 
in an application 
program that can 
create bitmap files. 
See your application’s 
documentation for 
instructions.

If you selected a 
multiple page layout 
option (as described in 
Using Multiple Page 
Layouts and Page 
Frames), your 
watermark will appear 
on each page in the 
layout.

Watermark 
drop-down list
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4 To change the watermark or specify how it appears, click the Settings  
button. You see the following dialog box:

5 To load a custom watermark you’ve created as a bitmap file in an 
application program, click the User Defined  button. You see the 
following dialog box:

Click here to select a 
predefined watermark

Click here to load a 
custom watermark 
you’ve created

Specify how you want 
your watermark to look 
using these options

See how your 
selections will 
look in the 
Layout graphic 

You can create up to 
10 custom watermarks 
using any bitmap file 
up to 15MB in size. 
With Windows NT, the 
file can be any size.

Click Browse  to select your 
bitmap file

Then type a name for 
your custom 
watermark here and 
click Save
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Click the Browse  button. You see a file selection dialog box. Navigate 
to the folder containing the bitmap file you want to use, select the file, 
and click OK.

Type a name for the custom watermark (up to 24 characters long) in 
the Watermark  field. Click the Save button to add it to the list, then 
click OK.

The custom watermark now appears as the selected watermark in the 
Watermark Settings dialog box and is shown in the on-screen graphic.

6 Select the way you want the watermark to appear by choosing the 
following options:

◗ Position  selects where you want the watermark to appear on your 
page: Center , Top-Left , Top-Center , Top-Right , Left , Right , 
Bottom-Left , Bottom-Center , or Bottom-Right . 

◗ Size adjusts the size of the watermark, either larger or smaller, as 
you move the slide bar.

◗ Color  lets you choose a color for your predefined watermark: 
Black , Blue , Aqua , Lime , Fuchsia , Red, or Yellow . You cannot 
select a color for a custom watermark; it is printed in its original 
colors.

◗ Intensity  sets the lightness or darkness of the watermark based on 
where you move the slide bar. 

7 If you’re finished changing Layout options, click OK to close the Layout 
dialog box.

To delete a custom 
watermark from the list, 
click the User Defined  
button, select the 
watermark, and click 
Delete .

The on-screen 
graphic changes to 
reflect all the settings 
you choose. If your 
monitor displays only 
16 colors, the 
Intensity adjustments 
are not shown in the 
Layout graphic.
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Follow the steps in these sections to use options in the Layout dialog box:

◗ Using the Fit to Page Option

◗ Adding a Watermark

◗ Using Multiple Page Layouts and Page Frames


���� ���  �� �� ���� ������

When you want to make the printed size of a document different from its 
original size, you can use your printer software’s Fit to Page  option to 
proportion it to fit on a selected paper size. 

Follow these steps to use the Fit to Page option:

1 Create your document in your application software.

2 Open the File menu and select Page Setup . You see the Page Setup 
dialog box.

3 Click the Paper Size  list and select your document’s size as 
determined by your application.

4 Click OK  to close the Page Setup dialog box.

5 Now open the File menu and select Print . You see the printer settings 
dialog box.
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6 Click the Layout icon. You see the Layout dialog box:

7 Select one of the following Fit to Page options:

◗ Select Off  to set the print proportion to 100%.

◗ Select On to automatically reduce or enlarge the document to fit on 
the paper size loaded in the printer. The Paper Size option beneath 
the Fit to Page setting becomes active. 

Fit to Page 
settings

Select the paper size you’ve 
loaded in the printer here

Paper graphic displays the selected 
paper size and 
document size
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Select the size of the paper you’ve loaded. This automatically sets 
the correct reduction/enlargement percentage to fit the document 
into the printable area on the selected paper size. The document 
size and paper size settings appear beneath the paper graphic. 

8 If you’re finished selecting Layout options, click OK. If you want to 
select more options, see Adding a Watermark and Using Multiple Page 
Layouts and Page Frames.
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You can add a watermark to each page in your document to emphasize 
its purpose or indicate how it should be handled. For example, you may 
want to add a watermark of the word “Confidential” to documents you 
don’t want distributed to other parties. Or you can add a custom PICT file 
of your company logo so your document looks like printed letterhead.

1 Open an application and select a document to print. Open the File 
menu and click Print .

2 In the printer settings dialog box, click the Layout button. You see 
the Layout dialog box.

3 To use one of the predefined watermarks, click the arrow in the Name 
list in the Watermark box and choose one of these:

Go to step 5.

Confidential
Draft
Urgent
Priority
Hot

Do Not Copy
For Your Eyes Only
Review Copy
Top Secret
Duplicate

To add a custom 
watermark, you must 
first create the 
watermark as a PICT 
file in an application 
program that can 
create PICT files. See 
your application’s 
documentation for 
instructions.

If you selected a 
multiple page layout 
option (as described 
in Using Multiple 
Page Layouts and 
Page Frames), your 
watermark will appear 
on each page in the 
layout.
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4 To load a custom watermark you’ve created as a PICT file in an 
application program, click the Add/Delete  button. You see the 
following dialog box:

Click the Add  button. You see a dialog box for selecting files. Navigate 
to the folder containing the PICT file you want to use, select the file, 
and click Open .

The name of your PICT file appears in the Mark Name field and is 
added to the Watermark List. Click the Save button to close the dialog 
box.

The custom watermark now appears as the selected watermark in the 
Layout dialog box and is shown in the layout graphic.

5 Now select the way you want the watermark to appear by choosing the 
following options. The layout graphic changes to reflect all the settings 
you choose.

◗ Color  lets you choose a color for your predefined watermark: 
Black , Blue , Aqua , Lime , Fuchsia , Red, or Yellow . You can’t 
select a color for a custom watermark; it prints in its original colors.

◗ Intensity  sets the lightness or darkness of the watermark based on 
where you move the slidebar. 

Click the Add  button to 
select a PICT file 

You can create up to 
10 custom watermarks 
from PICT files up to 
1MB in size. 

To delete a custom 
watermark from the 
list, click the 
Add/Delete  button, 
select the watermark, 
and click Delete .

If your monitor 
displays only 16 
colors, the Intensity 
adjustments are not 
shown in the Layout 
graphic. 
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◗ To adjust the size and position of the watermark, move the cursor 
over the Layout graphic. Four boxes appear in the corners of the 
graphic and the cursor changes to a hand.

To move the watermark, click anywhere inside the graphic and drag 
it into one of these positions: center, top-center, upper-right, 
middle-right, lower-right, bottom-center, upper-left, middle-left, or 
lower-left.

To resize the watermark, move the cursor over one of the corner 
boxes; the cursor changes to a pointing hand. Click and drag the 
box corner to reduce or enlarge the watermark.

6 If you’re finished changing Layout options, click OK to close the Layout 
dialog box. 

If you want to select more options, see Using Multiple Page Layouts 
and Page Frames.

Click and drag anywhere 
in here to move the 
watermark

Click and drag one of the 
corner boxes to resize the 
watermark
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If you’re printing a multiple page document and want a quick proof of each 
page printed on one piece of paper, you can select a Print Layout option. 
You can choose the way the pages are placed on the paper and add a 
lined frame to each page, if you want.

Follow these steps to use the Print Layout options:

1 Open an application and select a document to print.

2 Open the File menu and click Print . You see the printer settings dialog 
box.

3 Click the Layout button. You see the Layout dialog box.

4 To print multiple pages of your document on one sheet of paper, select 
either 2 Pages  or 4 Pages  in the Pages drop-down list.

5 The layout of the on-screen graphic shows the page order of how your 
document will print. To change the page order, click the arrow in the 
Page Order  drop-down list. Then select the page order you want to 
use.

6 If you want to frame each page’s contents with a thin black line, click 
the Print page frames  checkbox.

7 If you’re finished selecting Layout options, click OK. 

Click the arrow 
and select a 
multiple page 
layout
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You can get a preview of how your document will print with the Print 
Preview feature in your Macintosh printer software. Print Preview shows 
the results of the following printer software settings on your document:

◗ Print layout settings such as Fit to Page , Page Order , Watermark , 
Reverse Order , and Collate

◗ Page Setup options, such as Paper Size , Orientation , Rotate by
180 degrees , and Printable Area

1 Open an application and select a document to print.

2 Open the File menu and click Print . You see the printer settings dialog 
box.

3 Click the Print Preview icon. The Print  button changes to the 
Preview  button.

Click the Print Preview icon

The Print button 
changes to the 
Preview button
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4 Click the Preview  button. After a moment, you see the print preview 
dialog box:

5 The first preview page is the first page of your document. To change 
the preview page, click the or button to go back or forward one 
page, or enter a page number in the Page field.

6 To change the size of the preview, click the following buttons:

◗ Click to see the entire page, reduced to fit in the display area

◗ Click to see a mid-size preview

◗ Click to see the page enlarged with the most details

7 To print your document, click Print . To close the print preview dialog 
box and return to your application, click Cancel .

Help, Cancel, 
and Print 
buttons

Page control 
buttons

Preview 
image

Preview sizing 
buttons

When you click 
Cancel , the Preview 
and Print dialog 
boxes close, but your 
current print settings 
remain the same.
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When background printing is on, your printer software lets you work in 
other applications while printing takes place in the background. 
Background printing also lets you set the following printing options:

◗ Set a priority for the print job in the print queue

◗ Set a specific time for printing the print job

◗ Hold the print job for later printing

Follow these steps to set up background printing:

1 Open an application and select a document you want to print.

2 Open the File menu and click Print . You see the printer settings 
dialog box. 

3 Click the Background Printing icon. You see the following dialog 
box:

4 To turn background printing on or off, click the On  or Off  radio button.

You can also turn 
background printing 
on or off in the 
Macintosh Chooser.

Not available if 
background printing 
is turned off
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5 To select a priority for your print job in the queue of jobs waiting to 
print, click one of the following:

◗ Normal  to print in the order the job is received

◗ Urgent  to print before any Normal priority job

◗ Print at  to print at a specific time you enter in the day and time 
fields

◗ Hold  to keep the print job in the print queue until you’re ready to 
release it using EPSON Monitor 3; see Using Monitor3 for details.

6 Click OK  to save your settings and return to the printer settings dialog 
box. 

	�)��# ����� 	�����#�

After you’ve fine-tuned your printer settings for a special project, you can 
save the settings as a group. Then you can quickly reuse them the next 
time you print a similar project. You can save up to 10 groups of settings. 

1 Customize your printer settings, then access the Advanced dialog box 
as described in Customizing Print Quality and Special Effects. 

2 Click the Save Settings  button. 
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You see this dialog box:

3 Type a unique name for your settings (up to 16 characters) and click 
the Save button.

4 Click OK  to close the Advanced dialog box. The name of the custom 
settings group you created appears as the selected option in the 
Custom Settings list.

To use custom settings groups you created, click Custom . Then open the 
Custom Settings list and select the name of the group. The groups you 
created appear at the bottom of the list.

To revise or delete your custom settings, see Revising Your Custom 
Settings or Deleting Your Custom Settings.

Macintosh

Windows

When you want to 
use one of the custom 
settings groups you 
created but change a 
couple of its settings, 
you have to revise 
your custom settings 
group or create a new 
one. See Revising 
Your Custom 
Settings.
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To make one or two changes to your settings in a custom settings group, 
you can revise the group without recreating it from scratch. 

1 From the main printer settings dialog box, click Custom . Then select 
the name of the custom settings group you want to revise in the 
Custom Settings list.

2 Click the Advanced  button and change the printer settings.

3 When you’re finished changing the settings, click Save Settings . 

4 In Windows, select the name of the custom settings group you’re 
revising in the Custom Settings dialog box. (On a Macintosh, it’s 
automatically selected.)

5 If you’re using Windows, click Save. Click OK at the Save As dialog 
box to save your revised settings. (Click Cancel  to cancel your 
changes.)

On a Macintosh, click the Redefine  button. Then click Replace  at the 
confirmation dialog box to save your revised settings. (Click Cancel  to 
cancel your changes.)

�������� (��� ����� ��������

1 From the main printer settings dialog box, click Custom,  then click the 
Advanced button. 

2 Click Save Settings  on the Advanced dialog box. 

3 Select the custom settings group in the Custom Settings box, and click 
Delete . In Windows, click OK to confirm the deletion. 

If you want to create a 
new custom settings 
group, type a unique 
name for your 
settings (up to 16 
characters) and click 
Save.

You cannot delete 
any of the predefined 
document types.
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Your EPSON Stylus Photo 1200 lets you print on just about any kind of 
paper you want to use. You can get great results printing on various sizes 
of plain paper, letterhead, and envelopes, but you’ll get even better 
results with EPSON’s specially coated ink jet paper. 

For the best output, use EPSON’s photo-quality paper: ink jet paper, 
glossy film, and photo paper. 

For special projects, you can use a variety of EPSON papers designed for 
ink jet printers, ranging from transparencies to iron-on transfer paper. 

Follow the steps in this chapter on:

◗ Selecting the Right Settings for Your Paper

◗ Paper Loading and Handling Guidelines
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When you print on special papers, you need to choose the correct Media 
Type and Paper Size settings in your printer software. The table below 
lists the available EPSON papers and the corresponding Media Type 
setting for each one.

Paper name Size Part number Media Type setting

EPSON 360 dpi Ink Jet Paper A4
Letter
A3
Super B/A3

S041059
S041060
S041065
S041066

360 dpi Ink Jet 
Paper

EPSON Iron-On Cool Peel 
Transfer Paper

Letter S041153/S041155

EPSON High Quality Ink Jet Paper Letter
A4

S041111
S041117

Photo Quality Ink 
Jet Paper

EPSON Photo Quality Ink Jet 
Paper

A4
Letter
Legal
Super B/A3
B

S041061
S041062
S041067
S041069
S041070

EPSON Photo Quality Ink Jet 
Cards

A6
8 × 10 inches

S041054
S041122

EPSON Photo Quality Self 
Adhesive Sheets

A4 S041106
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To order EPSON papers and other media, contact your dealer or call 
EPSON Accessories at (800) 873-7766 (U.S. sales only). Or visit our web 
site at www.epsonsupplies.com (U.S. sales only). In Canada, please call 
(800) 873-7766 for dealer referral.

EPSON Photo Paper 4 × 6 inches
A4
Letter
Super B/A3
B

S041134
S041140
S041141
S041143
S041156

Photo Paper

EPSON Panoramic Photo Paper 8.3 in × 23.4 in S041145

EPSON Banner Photo Paper 13 in × 32.8 ft S041233

EPSON Photo Quality Glossy Film A4
Letter
A6
Super B/A3
B

S041071
S041072
S041107
S041074
S041075

Photo Quality 
Glossy Film

EPSON Photo Stickers Kit
(CD-ROM and paper)
EPSON Photo Stickers (refill)

A6

A6

S041144-KIT

S041144

EPSON Ink Jet Transparencies A4
Letter

S041063
S041064

Ink Jet 
Transparencies

EPSON Ink Jet Back Light Film A3 S041131 Ink Jet Back Light 
Film

Paper name Size Part number Media Type setting
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The following tips help you get the best results on any type of paper:

◗ Always handle sheets by the edges, and avoid touching the printable 
surface.

◗ When you load paper, make sure the printable side is facing up. 

◗ Load paper only up to the arrow mark on the left edge guide. 

◗ Return unused sheets and envelopes to their original package as soon 
as possible. See Paper for more storage information.

◗ If your paper package included protective sheets, cover the printed 
side of your paper with these sheets before stacking your paper.

◗ Use ink jet papers within one year of purchase; use glossy film and 
transparencies within six months. 

◗ Follow any specific instructions for your paper in the following sections:

◗ Letterhead, Preprinted Forms, and Legal-size Paper

◗ EPSON Photo Quality Glossy Film and Transparencies

◗ Envelopes

◗ EPSON Photo Paper

◗ EPSON Panoramic Photo Paper

◗ EPSON Banner Photo Paper

◗ EPSON Photo Quality Ink Jet Cards

◗ EPSON Photo Stickers

◗ EPSON Photo Quality Self Adhesive Sheets

Don’t use any cleaning 
sheets included with 
special paper; they 
may jam inside the 
printer.
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◗ EPSON Iron-On Cool Peel Transfer Paper

◗ EPSON Ink Jet Back Light Film
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Load the top edge first with the printable side up. When you load long 
paper, pull up the paper support extension and both output tray 
extensions.

Select Plain paper  as the Media Type setting, and be sure to choose the 
correct Paper Size setting in your printer software.
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Before you load glossy film or transparencies, put a support sheet 
(packed with the media) or a sheet of plain paper beneath the stack.

You can load up to 20 sheets of glossy film or up to 30 transparencies.

With Photo Quality Glossy Film, you may get better results by loading one 
sheet at a time. If you load multiple sheets, the minimum top margin you 
can use is 1.2 inches (30 mm). If you want to use a smaller top margin, 
load and print one sheet at a time.
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If your media has a cut corner, position it in the upper right corner in the 
sheet feeder.

Be sure to select the correct Media Type setting for your paper in the 
printer software.

◗ For Photo Quality Glossy Film, select Photo Quality Glossy Film

◗ For transparencies, select Ink Jet Transparencies

It’s best not to use 
the Maximum  
printable area setting 
in the printer software 
when printing on 
paper with a cut 
corner. Part of your 
document may print 
in the cut out area.

cut corner
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You can load up to 10 envelopes flap edge first, with the printable side up, 
as shown below:

When you print on envelopes or other thick media, set the paper 
thickness lever to the + position as shown below. (Return the lever to 
the 0 position before printing on regular media.)

Select Plain paper  as the Media Type and choose the correct envelope 
size as the Paper Size setting in the printer software.

If the stack of 
envelopes is more 
than 0.4-inch 
(10 mm) thick, press 
the envelope edges 
to flatten them before 
stacking or load one 
envelope at a time.
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You can use EPSON Photo Paper to print photographs that look almost 
as good as the ones you get from film processing. EPSON Photo Paper 
comes in a variety of sizes, from 4 × 6-inch, snapshot-size, to letter-size, 
to panoramic- and banner-size (on a roll). 

Instructions on using 4 × 6-inch Photo Paper is described below. See 
EPSON Panoramic Photo Paper and EPSON Banner Photo Paper for 
instructions on loading panoramic and banner size Photo Paper.

You can load up to 20 sheets of Photo Paper. Load the paper with the 
whiter (glossier) side face-up. Make sure you place a support sheet 
beneath the paper if it is included in the paper package.

EPSON 4 × 6-inch Photo Paper is perforated around the edges, so you 
can trim your printouts and “bleed” the photo—extend it to the edge of the 
paper—on all sides.To load 4 × 6-inch Photo Paper, follow these steps:

1 When you create the image in your application software, size it to 
4.25 × 6.25 inches so the image covers the perforations as shown.

To keep your 
printouts looking their 
best, store them in a 
resealable plastic bag 
or other airtight 
covering and protect 
them from heat, 
humidity, and direct 
sunlight.

trim size

printed image size

0.67 in

0.24 in

0.12 in

0.24 in0.12 in
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2 Position the perforated margins as shown and load up to 20 sheets 
with support sheets A and B beneath the stack.

3 Choose these printer software settings:

Photo Paper as the Media Type setting
EPSON Photo Paper 4 × 6 in  as the Paper Size setting
Maximum  as the Printable Area setting

4 After you print, fold the paper back and forth along the perforations and 
carefully tear off the margins.

You can use EPSON 
4 × 6-inch Photo 
Paper like a postcard. 
After printing on the 
glossy side of the 
Photo Paper, let your 
image dry a minute or 
so. Then set the 
paper thickness lever 
to the + position, 
reload the flattened 
card with the 
uncoated side up, 
and print your 
message in black ink 
using 360 dpi Ink Jet 
Paper  as the Media 
Type setting.
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You can use Panoramic Photo Paper to print large format panoramic 
photos. Before loading the paper, make sure it’s flat; if it curls, place it 
between two sheets of paper and put a heavy object on top to flatten it.

Before loading the paper, pull the printer’s paper support extension all the 
way up. Then load the paper one sheet at a time, printable side up. While 
holding the paper up by its top edge, press and release the 

 

E load/eject 
button to feed the paper into the printer. Select Photo Paper  as the Media 
Type and Panoramic 210 × 594 mm  as the Paper Size in your printer 
software. 
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You can use Banner Photo Paper on a roll to print photographic banners, 
panoramas, and signs up to 44 inches long. Before loading the paper, cut 
it to the desired length of your image plus 2 inches to account for the 
necessary margins. Make sure the cut sheet is flat; if it curls, flatten it 
following the instructions included in the paper package. Then remove the 
printer’s paper support and load the paper one sheet at a time, printable 
side up. Support the paper from underneath or by its edges, then press 
and release the 

 

E load/eject button to feed the paper into the printer. 

Select Photo Paper  as the Media Type and Banner  as the Paper Source 
in your printer software. Don’t select PhotoEnhance3 when printing on 
Banner Photo Paper.

An accessory Roll Paper Holder (0 10343 81750 0) is available for 
loading Banner Photo Paper. Contact your EPSON dealer or call EPSON 
Accessories at the number listed in Where To Get Help to order it.

Be sure to support 
your Panoramic 
Photo Paper or 
Banner Photo Paper 
as it ejects from the 
printer so it doesn’t 
fall onto the floor.
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You can load up to 30 cards at a time. Always place the included support 
sheet under the cards and load them as shown below. 

Set the paper thickness lever to the + position, as shown in Envelopes, to 
prevent smearing. When you’re ready to print, set the Media Type to 
Photo Quality Ink Jet Paper  and the Paper Size setting to the card size 
in your printer software. 
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Use these sheets of stickers to print small, decorated photos for use on 
cards, invitations, or other items. You’ll need to use an application that 
can create photo stickers, such as XLsoft’s StickerPiX.™

Load one sheet of Photo Stickers at a time. Make sure to place support 
sheets A and B that came with the stickers beneath the sheet. 

Select Photo Quality Glossy Film  as the Media Type setting and A6 
Index card 105  × 148 mm  as the Paper Size in your printer software.
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Use these sheets to print labels or stickers. You can load one sheet at a 
time. Make sure your adhesive sheets are fully adhered to their backing 
sheet before you load them.

When you’re ready to print, select Photo Quality Ink Jet Paper as the 
Media Type setting in your printer software.

!���� /���*�� ��� ���� ��
����� �
���

You can print photos, company logos, or anything else you want on these 
transfer papers, and then iron your images onto T-shirts or other cloth 
items. Load one sheet of transfer paper at a time. 

Be sure to select 360 dpi Ink Jet Paper  as the Media Type setting and 
reverse your image before you print it—especially if it includes text—so it 
will read correctly when it’s transferred. You can use the Flip Horizontal 
setting in your printer software to do this (see Customizing Print Quality 
and Special Effects for instructions).

After you print, follow the instructions that came with the paper to iron the 
image onto the shirt or other item.
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You can use EPSON Ink Jet Back Light Film to print crisp, translucent 
images for backlit display. Before loading the back light film, pull the 
paper support extension all the way up. Make sure the film is flat; if it 
curls, place it between two sheets of paper and put a heavy object on top 
to flatten it. Load one sheet at a time, with the white side face-up. 

Select Ink Jet Back Light Film  as the Media Type setting; your printer 
software automatically makes a mirror image of your design so it appears 
correctly when viewed from the reverse side.

Don’t use the 
Maximum Printable 
Area setting on the 
Paper tab in your 
printer software when 
you’re printing on 
EPSON Ink Jet Back 
Light Film.
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Your printer software includes several utilities for managing print jobs. 
You can use them to monitor your printer’s status and check on the 
current print job or jobs waiting to print. This chapter provides instructions 
for the following:

◗ Managing Print Jobs in Windows

◗ Managing Print Jobs on a Macintosh
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Your printer software offers three ways to monitor your print jobs:

◗ Progress Meter , which shows the progress of your current print job 
and the status of your printer. The Progress Meter appears each time 
you send a print job, as described in Using the Progress Meter. You 
can turn the Progress Meter on or off in the Speed & Progress dialog 
box; see Displaying the Progress Meter for details.

◗ Spool Manager  (not available with Windows NT), which displays your 
current print job files and lets you pause and cancel individual jobs. 
The Spool Manager appears in the taskbar at the bottom of the screen 
each time you print, as described in Using the Spool Manager.

◗ Status Monitor 2 , which provides detailed information about the 
status of your printer, as described in Using Status Monitor 2.

In addition, the Speed & Progress dialog box lets you optimize your 
system for the fastest transfer of data to your printer. See Optimizing Data 
Transfer for details.

Windows NT 4.0 
servers and 
workstations include 
a messenger service 
to alert you to printer 
errors or let you know 
when a print job is 
finished. If you have 
appropriate network 
access privileges or 
you’re controlling 
printing from the 
server, you can also 
set other options. See 
your Windows NT 
documentation for 
details.
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After you send a print job, the Progress Meter window appears on your 
screen:

The Progress Meter shows the progress of your print job and the status of 
your printer. You can use the buttons to cancel, pause, or restart your 
print job. 

If you installed Status Monitor 2, you also see information about how 
much ink you have left. You can also click the Detail  button to view the 
Status Monitor 2 Printer Status window. See Using Status Monitor 2 for 
more information.

You can select whether or not to display the Progress Meter. See 
Displaying the Progress Meter for instructions.

Click to pause 

Click to cancel 

Click to restart 

Click to view the Status 
Monitor 2 Printer Status 
window

This information 
appears only if 
you installed 
Status Monitor 2 
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You can control whether or not the Progress Meter appears when you 
send a print job using the Speed & Progress dialog box. To access the 
dialog box, you must open your printer software from the Windows 
Printers utility as described below.

1 Click Start , point to Settings , then click Printers .

2 Right-click the EPSON Stylus Photo 1200  printer icon and select 
Properties  (Windows 95 and 98) or Document Defaults 
(Windows NT) from the menu.

3 Click the Utility  tab. You see the Utility menu:

4 Click the Speed & Progress  button. 

Speed & 
Progress 
button

Utility tab

The Speed & 
Progress button is 
grayed out when you 
open your printer 
software through an 
application. You can 
access the Speed & 
Progress dialog box 
only through the 
Windows Printers 
utility as described 
here.
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You see this dialog box:

5 Click the Show Progress Meter  checkbox to control whether or not 
the Progress Meter appears when you send a print job.

For information about other options in the Speed & Progress dialog box, 
see Optimizing Data Transfer.

Select whether you 
want the Progress 
Meter to appear or not
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The Spool Manager (not available with Windows NT) displays the status 
of your print jobs and lets you control how they’re printed.

To open Spool Manager while you’re printing, click the EPSON 
Stylus Photo 1200 button on the taskbar at the bottom of the screen. 
You see the Spool Manager window:

To cancel, pause, resume, or restart a print job, click the job to highlight it; 
then click the corresponding command button on the bottom of the 
window.

If you’re having trouble printing, a print job may have stalled. Click on any 
print jobs marked Held , then click the Cancel  button. 

Print job file Command buttons
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Status Monitor 2 lets you view information about your printer and your 
print jobs in its main window and these detailed status windows:

◗ Status Alert Window , which reports printer errors, low ink levels, and 
other problems when they occur.

◗ Printer Status Window , which gives troubleshooting tips and detailed 
information about printer errors.

◗ Job Status Window , which shows print jobs that are currently printing 
or waiting to be printed.

To use Status Monitor 2, follow the instructions in these sections:

◗ Before you can view the main window or any of the status windows, 
you need to open Status Monitor 2, as described in Opening Status 
Monitor 2.

◗ To set up how you want printing monitored and to view a brief 
description of your printer status, see Using the Main Window.

◗ To access more detailed printer information, see Using the Detailed 
Status Windows. 

◗ If you want to adjust how often Status Monitor 2 checks your printer 
status, see Changing the Monitoring Interval. 

You can check printer 
status using Status 
Monitor 2 only when 
your printer is turned 
on and connected 
directly to your 
computer via a 
bidirectional port.
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To use Status Monitor 2 or view any of its status windows, you must first 
open it. Follow these steps:

1 Make sure your printer is turned on.

2 Click Start , point to Programs , click the Epson  folder, and click 
EPSON Status Monitor 2 . You see the main window, described in 
Using the Main Window.

If background monitoring is turned on (as described in the next section), 
you can open Status Monitor 2 by double-clicking the Background 
Monitoring icon on the taskbar in the bottom-right corner of your screen.
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Follow these steps to turn on background monitoring:

1 Make sure your printer is turned on and then open Status Monitor 2 as 
described above. The main window appears.

2 Open the Settings menu and select Background Monitoring .

3 Select either Monitor from restart  (to begin background monitoring 
after your next system restart) or Monitor now  (to begin background 
monitoring right away). The Background Monitoring icon appears 
on the taskbar in the lower-right corner of your screen.

The Background Monitoring icon remains on your taskbar even after 
you close Status Monitor 2; to reopen the utility, double-click the icon. The 
color of the icon also helps you monitor your printer status, as described 
in Using the Main Window below.

You can change 
the shape of the 
Background 
Monitoring icon by 
clicking Select 
background 
monitoring icon  in 
the Settings menu.

If you ever need to 
turn off background 
monitoring, follow 
steps 1 and 2, then 
select Stop 
monitoring now .
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When you start Status Monitor 2, you see the main window:

The Installed Printers list shows the name of your printer with a brief 
message describing its status. The color of the Installed Printer icon also 
indicates the printer status as follows:

Menu bar
Button bar

Installed 
Printer icon 
and name

Brief status messages 
appear here

The number of print 
jobs waiting to print 
appears here

Printer Name, Status, and 
Job Count title bars

Installed Printer 
icon color Status message

Green Ready to print

Yellow Ink level is low

Red Paper and/or ink is out, paper is jammed, or a 
communication error has occurred

If the Installed Printer 
icon is grayed out, 
your printer is either 
disconnected from 
your computer or 
turned off.
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The main window also lets you access more detailed information about 
your printer or job status through the Printer Status and Job Status 
windows. You can also set when and if you want the Status Alert window 
to notify you of changes in your printer status. See Using the Detailed 
Status Windows for more information.

���	 ����	�� �� �� ���� ������

If you’re monitoring more than one EPSON printer, you may want to 
delete any printers from the Installed Printers list that are not currently 
connected to save system resources. To do this, click the printer name in 
the Installed Printers list and select Delete Printer  from the Settings 
menu. To add a printer to the list, select Add Printers  from the Settings 
menu.

You can customize the appearance of items on the Status Monitor 2 main 
window using options in the View menu or using icons on the button bar. 
If you’re monitoring multiple printers, you can reorder them in the Installed 
Printers list by clicking Printer Name , Status , or Job Count  in the title 
bar.

Another option in the main window lets you adjust how often you want 
Status Monitor 2 to check your printer, as described in Changing the 
Monitoring Interval. 

If you see more than 
one EPSON printer in 
the Installed Printers 
list, Status Monitor 2 
has detected printer 
software for additional 
EPSON printers on 
your system. If you 
connect another 
EPSON printer, you 
can monitor it with 
Status Monitor 2 in the 
same way you monitor 
your EPSON Stylus 
Photo 1200.
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Status Monitor 2 features three status windows for viewing information 
about your printer and your print jobs, as described in these sections:

◗ Status Alert Window

◗ Printer Status Window 

◗ Job Status Window

To view any of the status windows, you must first open Status Monitor 2. 
See Opening Status Monitor 2 for details.

You can check printer 
status using Status 
Monitor 2 only when 
your printer is turned 
on and connected 
directly to your 
computer via a 
bidirectional port.
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You can set up the Status Alert window to appear automatically to report 
printer errors, low ink levels, and other problems when they occur, or to 
appear every time you print: 

To use the Status Alert window, you must turn on background monitoring 
and set the status alert preferences; see Setting Status Alert Preferences 
for instructions.

The Status Alert window gives a brief message describing your printer 
status. The color of the printer icon also indicates its current status, as 
described below:

Click here to close 
the Status Alert 
window

Click the printer name to 
highlight it, then click Details  
to open the Printer Status 
window; see Printer Status 
Window for more information

Installed Printer 
icon color Status message

Green Ready to print

Yellow Ink level is low

Red Paper and/or ink is out, paper is jammed, or a 
communication error has occurred

If the Installed Printer 
icon is grayed out, 
your printer is either 
disconnected from 
your computer or 
turned off.
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To view more printer status information, including troubleshooting tips and 
details about printer errors, click Details  to open the Status Monitor 2 
Printer Status window. See Printer Status Window for more information.
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To view the Status Alert window, you need to set Status Alert preferences 
for your printer. Follow these steps:

1 If you haven’t already done so, turn on background monitoring as 
described in Turning on Background Monitoring. 

2 Click EPSON Stylus Photo 1200  in the Installed Printers list.

3 Click the Monitoring Preferences icon or select Monitoring 
Preferences from the Settings menu. (You can also right-click the 
printer name in the Installed Printers list and select Monitoring 
Preferences  from the pop-up menu.) You see this dialog box:

Click to check 
this setting 

Select when you want the 
Status Alert window to 
appear: while printing, 
when errors occur, and/or 
when ink is low
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4 Click the Monitor this printer  checkbox.

5 Then turn on one or more of the Status Alert options to make the 
Status Alert window appear when the selected condition occurs. For 
example, if you turn on Show when errors occur , the Status Alert 
window appears only if a printing error occurs. If you select all the 
options, the Status Alert window appears whenever you print, 
encounter an error, or have low ink levels.
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For more details on the status of your printer, you can use the Printer 
Status window. The Printer Status window provides troubleshooting tips 
and detailed information about printer errors.

You can access the Printer Status window in different ways, depending 
on whether or not you’re currently printing:

◗ If you’re currently printing, click the Details  button on the Progress 
Meter (described in Using the Progress Meter) or in the Status Alert 
window (described in Status Alert Window).

◗ If you’re not currently printing, start your printer software, click the 
Utility  tab, then click the EPSON Status Monitor 2  icon. Or, open 
Status Monitor 2 as described in Opening Status Monitor 2, and click 
your printer name in the Installed Printers list. 

Then click the Printer Status icon or select Printer Status  from the 
Printer menu.
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You see the Printer Status window. Click the Current Status  tab to see 
the printer’s current status and troubleshooting tips. 

To check the amount of ink you have, click the Consumables  tab.

The Printer Information  tab isn’t used by the EPSON Stylus Photo 1200.

Printer status 
messages appear 

If an error occurs, 
troubleshooting tips 
appear here

The printer graphic 
changes to reflect the 
printer status

If your printer runs out of ink, 
click this button to display 
cartridge replacement 
instructions

These graphics indicate the 
amount of ink remaining in 
your cartridges 
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To view detailed information on the print jobs waiting to print, you can use 
the Job Status window (not available with Windows NT). There are two 
ways to open the window:

◗ Click the printer name in the Installed Printers list and click the icon 
or select Job Status  from the Printer menu.

◗ Right-click the printer name in the Installed Printers list and select Job 
Status  from the pop-up menu.

You see the Job Status window:

To pause or cancel a print job, first click its name in the Document Name 
list to highlight it. Then select either Pause Printing or Cancel Printing 
from the Document menu. To pause or purge all waiting print jobs, select 
Pause Printing or Purge Print Jobs  from the Printer menu.

The Job Status 
window is very similar 
to the Spool Manager 
window. Both allow 
you to pause, cancel, 
and restart print jobs. 
See Using the Spool 
Manager for more 
information.

Information on jobs currently printing or waiting to be printed 
appears here 

Menu 
bar
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You can adjust how often Status Monitor 2 checks your printer status. For 
example, if the Status Alert window takes a long time to appear after you 
send a print job, you may wish to decrease the monitoring interval. This 
will make the Status Alert window appear more quickly; however, shorter 
intervals may cause certain applications to run more slowly.

To adjust the monitoring interval, open the Monitoring Preferences dialog 
box by following these steps:

1 Open Status Monitor 2 as described in Opening Status Monitor 2.

2 In the main window, click your printer name in the Installed Printers list 
and click the Monitoring Preferences icon or select Monitoring 
Preferences from the Settings menu. The Monitoring Preferences 
dialog box appears:

3 Click the Monitoring Interval slider and drag it left or right to change the 
monitoring interval.

Select how often you 
want Status Monitor 2 
to check your printer 
status
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You can speed up the way your printer software processes multiple-copy 
print jobs using options in the Speed & Progress dialog box. You can also 
optimize your printer port for the fastest data transfer rate for EPSON 
printers, if your computer supports such transfers. 

To access the dialog box, you must open your printer software from the 
Windows Printers utility as described below.

1 Click Start , point to Settings , then click Printers .

2 Right-click the EPSON Stylus Photo 1200  printer icon and select 
Properties  (Windows 95 and 98) or Document Defaults 
(Windows NT) from the menu.

3 Click the Utility  tab. You see the Utility menu:

The Speed & 
Progress button is 
grayed out when you 
open your printer 
software through an 
application. You can 
access the Speed & 
Progress dialog box 
only through the 
Windows Printers 
utility as described 
here.

Speed & 
Progress 
button

Utility tab
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4 Click the Speed & Progress  button. You see this dialog box:

5 Select High Speed Copies  to speed up printing of multiple copies by 
creating hard drive space for the copies. If you have multiple hard 
drives, you can select a high speed copy folder for storing the copies. 

6 Select EPSON Printer Port  (not available on Windows NT 4.0) to 
optimize the transfer rate of your printer port for EPSON printers. You 
see one of these messages beneath the EPSON Printer Port option:

◗ High speed (DMA) transfer enabled  tells you that you’re already 
using fast DMA transfer mode.

◗ For higher data transfer rates, use DMA transfer  tells you that 
you can speed up printing by enabling DMA transfers on your 
system, if your computer supports them. See your computer 
documentation for instructions on using DMA transfers.

7 Click OK  to close the Speed & Progress dialog box and return to the 
Utility menu. Then click OK again to exit your printer software.

Select a folder for storing 
print data to speed up 
printing of multiple copies. 
(You don’t see this box if you 
have only one hard drive.)

Not available with 
Windows NT

If you see no 
message beneath the 
EPSON Printer Port 
option, you cannot 
enable DMA transfers 
on your system.



 ����� ���� !�"� ���� ���

����#��# ����� -�.� �� � ���������

Your Macintosh printer software includes two print job management 
utilities: EPSON Monitor3 and Status Monitor. It also includes a 
Configuration utility for setting up print monitoring options.

◗ Monitor3 lets you check the progress of your current print job and set 
priorities and print times for documents waiting to print. You can also 
cancel, pause, or restart a print job. See Using Monitor3 for details.

◗ The Status Monitor lets you check the level of ink in your printer. See 
Using the Macintosh Status Monitor for details.

◗ The Configuration utility lets you choose how you want to be notified of 
printer errors and where you want print job files stored. See Selecting 
Configuration Options for details.
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If you turned on background printing, Monitor3 starts automatically when 
you send a print job to the printer. You can then use the Monitor3 dialog 
box to check on your print jobs and cancel, pause, or restart them.

To use this utility, you need to turn on background printing and increase 
the memory allocation for Monitor3, as described in Setting Up Monitor3.

When background 
printing is turned off, 
you can cancel your 
print job by pressing 
the  and . (period) 
keys.

You can also turn on 
background printing 
from your printer 
software; see Using 
Background Printing 
on the Macintosh for 
instructions.
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1 Open the Chooser from the Apple menu and select the SP 1200 icon. 
Then select the port you’re using.

2 Under Background Printing, click On and close the Chooser.

3 To increase the memory allocation, select EPSON Monitor3  in the 
Extensions folder in your System folder. Then choose Get Info  from 
the File menu and set the Memory Requirements  to 2000K or 3000K, 
depending on your system’s available RAM.
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After you send a print job, you see the EPSON Monitor3 dialog box:

You may need to 
perform different or 
additional steps to 
allocate memory, 
depending on your 
Macintosh OS 
version; see your 
Macintosh 
documentation for 
more information.

Current print 
job

Jobs waiting 
to print

Click to set 
priorities or print 
times for waiting 
print jobs

Progress bar



 ����� ���� !�"� ���� ��	

The progress bar tracks the progress of the current print job. To pause, 
cancel, or restart a print job (either the current one or any job waiting to 
print), click the document’s name to highlight it. Then click one of the 
following buttons: 

◗ click  to cancel 

◗ click  to pause

◗ click  to restart 

If you want to change the printing priority of a print job or set a specific 
time for it to print, click Show details  at the bottom of the window. The 
Priority list becomes active:

If the Monitor3 dialog 
box does not appear, 
click the current 
application icon at the 
right end of the menu 
bar and select EPSON 
Monitor3 from the 
drop-down menu.

If you see a stop sign 
icon and the message 
Print queue on hold  
in the EPSON 
Monitor3 dialog box, 
select Start print 
queue  from the Printer 
menu to release the 
queue and resume 
printing.

Priority list box

Settings selected for 
the highlighted print job 
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Click the name of the document whose job priority you want to change. 
Then click the Priority  list box and select one of the following settings:

◗ Normal prints the job in the order it’s received

◗ Urgent moves the job before any Normal priority jobs in the print 
queue

◗ Hold keeps the job in the print queue until you’re ready to release it for 
printing by clicking the restart icon

◗ Print Time  opens the Set Print Time dialog box:

Enter the time and date when you want the document to print, then 
click OK. 
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You can use the Status Monitor to check the level of ink in your printer. 
Follow these steps:

1 Choose Page Setup  or Print from the File menu in your application. 
You see the printer settings dialog box.

2 Click the Utility icon. You see the Utility menu:

For information 
about these utilities, 
see Maintenance 
and Transportation
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3 Click the EPSON Status Monitor  icon. The software checks the 
amount of ink remaining in the printer and displays the Status Monitor 
window:

4 To recheck the ink level, click the Update  button. To close the Status 
Monitor, click OK.

Click to recheck the 
ink level
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You can configure the way you want the printer to handle error and 
warning messages, ink level checks, and temporary spool folders in the 
Configuration Settings dialog box. Follow these steps:

1 Choose Page Setup  or Print from the File menu in your application. 
You see a printer settings dialog box.

2 Click the  Utility icon. You see the Utility menu.

3 Click the Configuration  button. You see the Configuration Settings 
dialog box:

Select how you want your 
system to notify you of 
errors and warnings

Select where you want print 
job files stored

Click here to check for 
errors and/or the ink level 
before printing

Click here to return to the default settings
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4 Select the following configuration options:

◗ Error notification  lets you select whether you want your system to 
beep and display error message text or just display text if your 
printer encounters an error.

◗ Warning  lets you choose whether warning messages beep and 
display text or just display text.

◗ Temporary Spool folder  and Temporary High Speed Copies 
folder  let you select the folders on your hard disk that store the 
temporary print job and high speed multiple-copy print job files 
created when you send a job to the printer. Click the Select  button 
to change to a different folder.

◗ Click the Check for errors before starting to print checkbox if you 
want your software to check for errors before starting your print job.

◗ Click the Check the ink level before starting to print checkbox if 
you want your software to check for a low ink condition before 
starting your print job.

5 When you’ve finished changing your configuration options, click OK to 
return to the Utility menu.

Warning messages, 
such as low ink, allow 
printing to continue; 
error messages are 
more serious and 
cause printing to stop.
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It’s easy to keep your EPSON Stylus Photo 1200 printer working well. 
Just follow the simple instructions in this chapter for: 

◗ Replacing an Ink Cartridge

◗ Cleaning the Print Head

◗ Aligning the Print Head

◗ Cleaning the Printer

◗ Transporting the Printer
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When the 

 

B black or 

 

A color ink out light flashes, the indicated cartridge 
is low on ink. This is a good time to make sure you have a new cartridge. 
When the light stays on, the cartridge is empty and you need to replace it.

Use these EPSON ink cartridges within six months of installing them and 
before the expiration date on the package:

Black ink cartridge S020187
Color ink cartridge T001011

To ensure good 
results, use genuine 
EPSON cartridges 
and do not refill 
them. Other products 
may cause damage 
to your printer not 
covered by EPSON’s 
warranty.
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When you need new ink cartridges, contact your dealer or call EPSON 
Accessories at (800) 873-7766 (U.S. sales only). Or visit our web site at 
www.epsonsupplies.com (U.S. sales only). In Canada, please call 
(800) 873-7766 for dealer referral.

If you need to replace an ink cartridge before  the lights flash (because the 
ink is too old, for example), follow the instructions in Replacing an 
Outdated Ink Cartridge.
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You can replace a cartridge when the 

 

B black or 

 

A color ink out light is 
either flashing or on. (If you perform these steps when both  ink out lights 
are off , the printer cleans the print heads, as described in Cleaning the 
Print Head.) Follow these steps to replace ink cartridges:

1 Remove the new ink cartridge from its packaging. 

2 Remove only  the yellow part of the tape seal on top as shown below. 
Don’t pull off the blue portion or try to remove the clear seal 
underneath the cartridge .

You must remove the 
yellow tape from the 
top of the cartridge or 
you will permanently 
damage it. Do not 
remove the clear seal 
from the bottom of 
the cartridge; ink will 
leak out.

To avoid damaging 
the printer, never 
move the print head 
by hand. Black cartridge Color cartridge

Remove the yellow tape 
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3 Make sure the printer is turned on and not printing, then open the 
printer cover.

4 Press the 

 

R cleaning button and hold it for about three seconds until 
the print head moves left and the 

 

P power light begins flashing. 

5 Pull up the ink cartridge clamp. The cartridge rises up from its holder.

6 Lift the cartridge out of the printer and dispose of it carefully. 

7 Lower the new ink cartridge into its holder with the label facing up and 
toward the back of the printer. Then press down the ink cartridge 
clamp until it locks in place.

8 If you need to replace the other ink cartridge, repeat steps 5 through 7 
before going on to step 9.

Don’t open the clamp 
or remove a cartridge 
except to replace it 
with a new one. Once 
you remove a 
cartridge, you can’t 
reuse it, even if it 
contains ink.

If ink gets on your 
hands, wash them 
thoroughly with soap 
and water. If ink gets 
into your eyes, flush 
them immediately 
with water.
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9 Press the 

 

R cleaning button and close the printer cover. The printer 
moves the print head and begins charging the ink delivery system. The 

 

P power light flashes, and the printer makes various sounds. 

Charging takes about one minute. When it’s finished, the 

 

P power light 
stops flashing and stays on.
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If an ink cartridge is more than six months old, you may need to replace it. 
How can you tell? You may notice that your printouts don’t look as good 
as they used to. If print quality doesn’t improve after cleaning and aligning 
the print head, you can replace one or both cartridges.

Follow these steps to replace an ink cartridge before  the 

 

B black or 

 

A color ink out light is flashing or on:

1 Remove the new ink cartridge from its packaging. 

2 Remove only  the yellow part of the tape seal on top as shown below. 
Don’t pull off the blue portion or try to remove the clear seal 
underneath the cartridge .

Never turn off the 
printer while the 
P power light is 
flashing, unless the 
printer hasn’t moved 
or made any noise for 
more than 5 minutes.

You must remove the 
yellow tape from the 
top of the cartridge or 
you will permanently 
damage it. Do not 
remove the clear seal 
from the bottom of 
the cartridge; ink will 
leak out. Black cartridge Color cartridge

Remove the yellow tape 
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3 Make sure the printer is turned on and not printing, then open the 
printer cover.

4 Press the 

 

E load/eject button and hold it down for three seconds until 
the print head moves to the left and the 

 

P power light begins flashing.

5 Pull up the ink cartridge clamp. The cartridge rises up from its holder.

6 Lift the cartridge out of the printer and dispose of it carefully. 

7 Lower the new ink cartridge into its holder with the label facing up and 
toward the back of the printer. Then press down the ink cartridge 
clamp until it locks in place.

8 If you need to replace the other ink cartridge, repeat steps 5 through 7 
before going on to step 9.

To avoid damaging 
the printer, never 
move the print head 
by hand.

Don’t open the clamp 
or remove a cartridge 
except to replace it 
with a new one. Once 
you remove a 
cartridge, you can’t 
reuse it, even if it 
contains ink.

If ink gets on your 
hands, wash them 
thoroughly with soap 
and water. If ink gets 
into your eyes, flush 
them immediately 
with water.
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9 Press the 

 

E load/eject button and close the printer cover.

The printer moves the print head and begins charging the ink delivery 
system. The 

 

P power light flashes and the printer makes various 
sounds. 

Charging takes about one minute. When it’s finished, the 

 

P power light 
stops flashing and stays on.

�������# ��� ����� ����

If your printed image is unexpectedly light or faint, or dots are missing 
from the image, you may need to clean the print head. This unclogs the 
nozzles so they can deliver ink properly.

Cleaning the print head uses ink, so clean it only if print quality declines. 
You can clean the print head in either of the following ways:

◗ Using the Head Cleaning Utility in your printer software (when 
connected to a local port, not over a network)

◗ Using the Control Panel buttons on your printer

When you don’t use 
your printer for a long 
period, the print 
quality can decline. 
It’s a good idea to turn 
the printer on at least 
once a month to 
maintain good print 
quality.
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Follow these steps to run the Head Cleaning utility:

1 Make sure the printer is turned on but not printing, and both  the 

 

B black and 

 

A color ink out lights are off .

2 Start an application and open a document.

3 Access the printer settings dialog box as described in Printing from 
Windows or Printing from a Macintosh.

4 Click the Utility  tab (Windows) or the Utility icon (Macintosh). 
You see the Utility menu.

5 Click the Head Cleaning  icon.

6 Follow the instructions on the screen to clean the print head. Cleaning 
takes a little over a minute, during which the printer makes some noise 
and the 

 

P power light flashes. 

When the 

 

P power light stops flashing, run a nozzle check to test the 
results and reset the cleaning cycle.

7 Make sure paper is loaded in the printer and click Print nozzle check 
pattern  (Windows) or Confirmation  (Macintosh). Then click Next . The 
nozzle check pattern prints on your printer; see Examining the Nozzle 
Check Pattern for details.

8 If the nozzle check pattern is filled in completely, click Finish .

If the pattern is missing dots, click Clean  to clean again. If you don’t 
see any improvement in the print quality after cleaning two or three 
times, check the solutions in Improving Print Quality.

Never turn off the 
printer while the 
P power light is 
flashing, unless the 
printer hasn’t moved 
or made any noise for 
more than 5 minutes.
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Follow these steps to clean the print head:

1 Make sure the printer is turned on but not printing, and both  the 

 

B black and 

 

A color ink out lights are off . 

2 Press the 

 

R cleaning button and hold it down for three seconds. 
Cleaning takes a little over a minute, during which the printer makes 
some noise and the 

 

P power light flashes. 

3 After the 

 

P power light stops flashing, print a page to test the print 
quality and reset the cleaning cycle.

If you’re connected directly to the printer, run a nozzle check. Then go 
to step 4.

If you’re printing over a network, open an application and print a 
document containing black and color data. Then go to step 8.

4 Start an application, open a document, and access the printer settings 
dialog box as described in Printing from Windows or Printing from a 
Macintosh. 

5 Click the Utility  tab (Windows) or the  Utility icon (Macintosh). You 
see the Utility menu.

6 Make sure paper is loaded in the printer, click the Nozzle Check icon, 
and click Next . The nozzle check pattern prints on the printer; see 
Examining the Nozzle Check Pattern for details.

7 If the nozzle check pattern is filled in completely, click Finish . If the 
pattern is missing dots, click Clean  to clean again.

8 If you don’t see any improvement in the print quality after cleaning two 
or three times, check the solutions in Improving Print Quality.

Never turn off the 
printer while the 
P power light is 
flashing, unless the 
printer hasn’t moved 
or made any noise for 
more than 5 minutes.
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Examine the nozzle check pattern you print. It should look something like 
this:

Each staggered horizontal and straight vertical line should be complete, 
with no gaps in the dot pattern. If your printout looks okay, you’re done. If 
any dots are missing, as shown below, clean the print head again; see 
Cleaning the Print Head for instructions.

missing dots
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If your printouts contain misaligned vertical lines, you may need to align 
the print head. Your printer must be connected to a local port, not on a 
network, to use the Print Head Alignment utility. Follow these steps:

1 Make sure the printer is turned on and paper is loaded.

2 Start an application and open a document.

3 Access the printer settings dialog box as described in Printing from 
Windows or Printing from a Macintosh.

4 Click the Utility  tab (Windows) or the Utility icon (Macintosh). You 
see the Utility menu.

5 Click the Print Head Alignment  icon.

6 Follow the instructions on the screen to print a test page.

7 Select the most precise alignment pattern from the printed choices on 
the test page. Enter the number of the best aligned pattern following 
the instructions on the screen.

Load paper that’s at 
least 8.27 inches 
(210 mm) wide. This 
prevents ink from 
spraying inside the 
printer and smudging 
your printouts.

For the best results, 
load EPSON ink jet 
paper in the printer 
whenever you check 
the print head 
alignment.
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To keep your printer working at its best, you should clean it several times 
a year. Follow these steps:

1 Turn off the printer, unplug the power cord, and disconnect the printer 
cable.

2 Remove all the paper from the sheet feeder.

3 Clean the exterior of the printer with a soft, damp cloth. 

4 Clean ink out of the printer’s interior with a soft, damp cloth.

Don’t touch the gears 
inside the printer.

Never use alcohol or 
thinner for cleaning; 
they can damage the 
printer components 
and case.

Don’t use a hard or 
abrasive brush.

Don’t get water on the 
printer components.

Don’t spray lubricants 
or oils inside the 
printer.
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If you move your printer some distance, you need to prepare it for 
transportation in its original box. Follow these steps:

1 Turn on the printer and wait until the print head locks in the far right 
position. Then turn off the printer.

2 Unplug the power cord from the electrical outlet. Then disconnect the 
interface cable from the printer.

3 Remove any paper from the printer and remove the paper support.

4 Push in the output tray extensions and close the tray.

5 Repack the printer and attachments in the original box using the 
protective materials that came with it. See the unpacking sheet that 
was packed with your printer.

Be sure to keep the printer level as you transport it. If you notice a decline 
in print quality after transporting the printer, clean the print head (see 
Cleaning the Print Head); if output is misaligned, align the print head (see 
Aligning the Print Head). 

To avoid damage, 
always leave the ink 
cartridges installed 
when transporting 
the printer.
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As you use your printer, you may occasionally experience a paper jam or 
other problem. The first thing you should do is diagnose the problem, 
following the guidelines in this chapter. Then try the most likely solutions 
until the problem is fixed. 

This chapter covers the following problems and solutions:

◗ Diagnosing Problems

◗ Improving Print Quality

◗ Solving Printing Problems

◗ Solving Printer Software Problems

◗ Fixing Paper Problems

◗ Solving Miscellaneous Printout Problems

◗ Where To Get Help
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There are a number of ways to diagnose printer problems:

◗ To identify the most common problems, check the printer’s lights; see 
Checking the Control Panel Lights for details.

◗ You can also view the Printer Status window to identify common 
problems, if you installed Status Monitor 2 with Windows. For 
instructions, see Printer Status Window. On a Macintosh, you can 
check your ink levels using the Status Monitor; see Using the 
Macintosh Status Monitor for details.

◗ To determine whether the problem is caused by the printer or some 
other source, run a printer operation check. See Running a Printer 
Operation Check for instructions.

◗ If you see an error message about your printer settings or have 
problems with color quality, you may need to confirm your Printer ID 
number. See Confirming the Printer ID Number for details.

◗ If any of the suggested solutions in this chapter tell you to uninstall and 
then reinstall your printer software, see the Printer Basics book for 
instructions.

◗ For more troubleshooting information, check the Help programs and 
the ReadMe files in the EPSON program group or folder. 

◗ If none of the suggested solutions solve your problem, contact your 
EPSON dealer or see Where To Get Help.
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Follow these guidelines when the control panel lights come on or flash:

 

S

 

 
flashing

When the 

 

S paper out light flashes, paper is jammed in the 
printer. Turn off the printer, remove all the paper (including 
any pieces torn off inside), then reload the stack. Turn on 
the printer and press the 

 

E load/eject button. For tips on 
avoiding paper jams, see Paper jams inside the printer. 

 

S
on

When the 

 

S paper out light comes on, your paper is out or 
incorrectly loaded. Load paper in the feeder and then press 
the 

 

E load/eject button. 

 

B or 

 

A
flashing

When an ink out light flashes, your ink supply is low. Make 
sure you have a replacement cartridge.

 

B or 

 

A
on

When an ink out light comes on, you need to replace the 
ink cartridge. See Replacing an Ink Cartridge for 
instructions.

power button

load/eject button

cleaning button

paper out light

color ink out light

black ink out light

power light
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You can run a printer operation check to determine whether the problem 
comes from the printer itself or some other source. If the check page 
prints, the problem lies in your software or application settings, the 
interface cable, or your computer. If the check page does not print 
correctly, you may have a problem with your printer. See the suggestions 
in this chapter for possible solutions.

1 Make sure both the printer and computer are turned off.

2 Disconnect the interface cable from the printer.

3 Make sure paper is loaded in the printer.

4 Hold down the 

 

E load/eject button, then press and release the 

 

P power 
button. Continue holding down the 

 

E load/eject button until the 

 

P power light starts to flash, then release it.

The printer prints its ROM version number, an ink counter code, and a 
nozzle check pattern (shown in Examining the Nozzle Check Pattern). 

5 To end the check, turn off the printer. Then reconnect the interface 
cable and turn on your printer and computer.

 

P S 
flashing 

 

B A
on

When the 

 

P power and 

 

S paper out lights flash and the 

 

B 
black and 

 

A color ink out lights come on, jammed paper 
may be blocking movement of the print head. See The 
Ppower and S paper out lights are flashing and the B black 
and A color ink out lights are on for more information.

 

P S B A
flashing

When all the lights flash, your printer may have an internal 
error. See All the lights are flashing for more information.

Load paper that’s at 
least 8.27 inches 
(210 mm) wide. This 
prevents ink from 
spraying inside the 
printer and smudging 
your printouts.
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If you’re using Windows, you can use the Printer and Option Information 
utility to confirm the Printer ID. Color quality may improve after you 
confirm the ID number.

If you’re using Status Monitor 2, this information is updated automatically. 
However, if a message appears prompting you to enter settings or if you 
change the printer’s configuration, you’ll need to update the Printer ID 
manually. Follow these steps:

1 Make sure paper is loaded in the printer.

2 Access the main printer settings dialog box as described in Printing 
from Windows.

3 Click the Utility  tab. Then click the Printer and Option Information 
icon.

4 Click the Settings Sheet  button. The printer prints the Printer ID on a 
sheet of paper.

5 Make sure the Printer ID shown in the Printer and Option Information 
dialog box matches the ID on the Settings Sheet. If they don’t match, 
change the ID numbers in the dialog box to match those on the 
Settings Sheet.

6 Click OK  to exit and save your settings.

Load paper that’s at 
least 8.27 inches 
(210 mm) wide. This 
prevents ink from 
spraying inside the 
printer and smudging 
your printouts.
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If you find that your print quality has declined, you can often improve it by 
doing one of the following:

◗ Clean the print head following the instructions in Cleaning the Print 
Head.

◗ Use higher quality paper appropriate for your print job. See Selecting 
the Right Settings for Your Paper for a list of EPSON papers.

◗ Match the Media Type in the printer software to the type of paper you 
loaded in the printer. Then the printer software can automatically select 
other settings for the best quality. (See Printing from Windows or 
Printing from a Macintosh for details.)

◗ Turn off High Speed mode in the printer software, as described in 
Customizing Print Quality and Special Effects.

◗ Make sure Economy mode is turned off in the printer software, as 
described in Customizing Print Quality and Special Effects.

◗ Check the status of the 

 

B black and 

 

A color ink out lights, then replace 
the ink cartridges, if necessary, as described in Replacing an Ink 
Cartridge.

See the following tables for some detailed solutions to print quality 
problems.
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The printed image has horizontal banding

Possible cause Solution

The Media Type setting 
doesn’t match the 
loaded paper.

Make sure the Media Type setting matches the paper you’re using. See 
Printing from Windows or Printing from a Macintosh for instructions.

The printable side of 
the paper is face down.

Remove the paper and reload it with the printable side face up. See 
Paper Loading and Handling Guidelines for instructions.

The print head nozzles 
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The ink cartridges are 
low on ink.

Check the 

 

B black and 

 

A color ink out lights to see which cartridge you 
may need to replace. See Replacing an Ink Cartridge for instructions.

The MicroWeave option 
is not turned on.

Turn on MicroWeave (if available) in the Advanced dialog box. See 
Customizing Print Quality and Special Effects for more information.

The Maximum Printable 
Area setting is turned 
on.

Select Standard  as the Printable Area setting to avoid banding in the 
expanded margin area. See Selecting Paper Size and Orientation 
Options for more information.

The paper thickness 
lever is in the + 
position.

Set the paper thickness lever to the 0 position and try printing again. 
See Envelopes for instructions.
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Vertical lines are misaligned or vertical banding appears

The printed image has incorrect or missing colors

Possible cause Solution

The print head nozzles 
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The paper thickness 
lever is in the + 
position.

Set the paper thickness lever to the 0 position and try printing again. See 
Envelopes for instructions.

The High Speed 
setting is turned on.

Turn off the High Speed setting if vertical lines are misaligned. See 
Customizing Print Quality and Special Effects for information.

The print head is 
misaligned.

Run the Print Head Alignment utility. See Aligning the Print Head for 
instructions.

The printable side of 
the paper is face 
down.

Remove the paper and reload it with the printable side face up. See 
Paper Loading and Handling Guidelines for instructions.

Possible cause Solution

The Ink option is set to 
Black .

Change the Ink setting to Color . See Printing from Windows or Printing 
from a Macintosh for instructions.

The Media Type 
setting doesn’t match 
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See 
Printing from Windows or Printing from a Macintosh for instructions.
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The Halftoning and 
Color Management 
options are set 
incorrectly for your 
document type.

Use the correct settings for the project you’re printing, following the 
instructions in Customizing Print Quality and Special Effects and 
Customizing Color Settings.

The printable side of 
the paper is face 
down.

Remove the paper and reload it with the printable side face up. See 
Paper Loading and Handling Guidelines for instructions.

The ICM (Windows 95 
or Windows 98 only), 
sRGB (Windows 98), 
or ColorSync 
(Macintosh) setting is 
incorrect for your 
document.

Use the Automatic mode setting or choose a different Rendering Intent 
setting (Macintosh). See Custom Printing and Using ColorSync on the 
Macintosh for more information.

The print head nozzles 
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The ink cartridges are 
low on ink or one or 
more ink colors are 
empty.

Check the 

 

B black and 

 

A color ink out lights to see which cartridge you 
may need to replace. See Replacing an Ink Cartridge for instructions.

Possible cause Solution
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The printed image is faint or has gaps

The colors displayed 
on your monitor don’t 
match the printed 
colors.

Because your monitor and printer use different technologies to represent 
colors, your printed colors can’t exactly match the colors you see on your 
monitor screen. Use the ICM (Windows 95 or Windows 98 only), sRGB 
(Windows 98), or ColorSync (Macintosh) settings to get as close a 
match as possible. See Custom Printing for more information.

The color settings in 
your application 
software need 
adjustment.

You may be able to adjust various color settings in your application 
software. See your software documentation for more information.

Possible cause Solution

The print head nozzles 
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The Media Type 
setting doesn’t match 
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See 
Printing from Windows or Printing from a Macintosh for instructions.

The loaded paper is 
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side face 
up. See Paper Loading and Handling Guidelines for instructions.

The ink cartridges are 
low on ink.

Check the 

 

B black and 

 

A color ink out lights to see which cartridge you 
may need to replace. See Replacing an Ink Cartridge for instructions.

Possible cause Solution
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The printed image is blurry or smeared

Possible cause Solution

The loaded paper is 
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side face 
up. See Paper Loading and Handling Guidelines for instructions.

The paper thickness 
lever is in the wrong 
position.

Set the paper thickness lever to the + position to print on envelopes or 
other thick media; set the lever to the 0 position to print on thinner media 
types. See Envelopes for instructions, then try printing again.

The paper is damp or 
the printable side is 
face down.

Remove the paper and reload a new stack with the printable side face 
up. See Paper Loading and Handling Guidelines for instructions.

You loaded special 
media without a 
support sheet.

Follow the special media loading instructions in Paper Loading and 
Handling Guidelines and on the paper packaging for media that require 
support sheets. Also try loading your media one sheet at a time.

You tried to print on 
cardboard or other 
non-recommended 
media.

Make sure your paper or media meets the specifications listed in Paper. 
If your printouts are still blurry after you change paper, clean the print 
head as described in Cleaning the Print Head.

The Media Type 
setting doesn’t match 
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See 
Printing from Windows or Printing from a Macintosh for instructions.

Ink has leaked inside 
the printer.

Clean carefully inside the printer to remove spilled ink. See Cleaning the 
Printer for instructions.
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You’re using the 
High Speed and 
MicroWeave settings 
with a misaligned print 
head.

Turn off High Speed, following the instructions in Customizing Print 
Quality and Special Effects. Then run the Print Head Alignment utility as 
described in Aligning the Print Head.

The resolution of your 
image may be too low.

If a photographic image looks grainy or rough, try using the 
PhotoEnhance3 and Sharpness setting to improve the quality of your 
printout. See Customizing Color Settings for details. You can also 
increase the image resolution using your image-editing software, or 
decrease the size of the image.

Possible cause Solution
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If the printer won’t print, first check that:

◗ The printer is turned on and the 

 

P power light is on, but not flashing.

◗ Paper is loaded in the printer.

◗ The printer is plugged into a working electrical outlet that’s not 
controlled by a switch or timer.

◗ The interface cable is securely connected to the printer and computer. 

If you still can’t print, check the following solutions.

All lights are off

Only the 

 

Ppower light is on, but nothing prints

Possible cause Solution

The printer is not 
receiving power.

Try these solutions:
◗ Make sure the printer is turned on.
◗ Turn off the power and plug in the power cord securely.
◗ Make sure the outlet is operable and not controlled by a switch or

timer. Try another outlet.

Possible cause Solution

The interface cable is 
disconnected.

Turn off your printer and computer, then connect the cable securely. 
Make sure the cable meets the printer’s specifications, as described in 
Windows System Requirements and Macintosh System Requirements.

The printer has an 
internal problem.

Turn off the printer and computer, disconnect the interface cable, and 
run a printer check as described in Running a Printer Operation Check.
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The printer or 
application software is 
installed incorrectly.

If the printer operation check works, make sure your printer and 
application software are correctly installed. If you’re printing on a 
Windows network, you may need to set up your printer for network 
printing, as described in the Printer Basics book.

Your computer doesn’t 
have enough memory 
to handle the file you’re 
printing.

Try the following:
◗ Close any open applications, including screen savers and virus scan

programs.
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your display or monitor.
◗ Add more memory to your computer.

Printing is stalled. In Windows, delete the stalled print jobs in Spool Manager; see Using 
the Spool Manager for instructions. In Windows NT, uninstall the 
EPSON Printer Port. Click Start , point to Programs , EPSON Printers , 
and select EPSON Printer Port Uninstall .

On a Macintosh, delete stalled print jobs using Monitor3 (see Using 
Monitor3) or open the Extensions folder, EPSON folder, and Spool 
folder, and then delete any queued files.

The print head nozzles 
are clogged or the ink 
cartridges are too old.

Clean the print head; see Cleaning the Print Head for instructions. If 
cleaning doesn’t help, replace the cartridges. For information on 
cartridge life and replacement instructions, see Replacing an Ink 
Cartridge.

Possible cause Solution
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The 

 

S paper out light is flashing or on

A 

 

B black or 

 

A color ink out light is flashing or on

The 

 

Ppower and 

 

S paper out lights are flashing and the 

 

B black and 

 

A color 
ink out lights are on

Possible cause Solution

If flashing, paper is 
jammed.

Remove the paper and follow the guidelines for preventing jams as 
described in Paper jams inside the printer.

If on, paper is used up 
or is loaded incorrectly.

Load paper or remove the stack and reload it as described in the Start 
Here card and in Paper Loading and Handling Guidelines. Then press 
the 

 

E load/eject button to turn off the 

 

S paper out light and resume 
printing.

Possible cause Solution

If flashing, the ink 
supply is getting low.

You need to replace the indicated ink cartridge soon; see Replacing an 
Ink Cartridge for instructions.

If on, the ink cartridge 
is empty.

You must replace the indicated ink cartridge now to be able to print; see 
Replacing an Ink Cartridge for instructions.

Possible cause Solution

Jammed paper may be 
blocking movement of 
the print head.

Turn off the printer, wait a few seconds, and turn it back on to eject any 
paper. If no paper is ejected, turn off the printer, remove the jammed 
paper, and turn it on again. If the lights are still flashing and on, contact 
your EPSON dealer or see Where To Get Help.
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All the lights are flashing

The printer has finished charging the ink cartridge, but the 

 

Ppower light is 
still flashing

Possible cause Solution

You haven’t removed 
all the packing material 
from the printer.

Remove the tape and other packing material following the instructions 
on the unpacking sheet. 

An internal error may 
have occurred.

Turn off your printer, wait a few seconds, and turn it on again. If the 
lights still flash or stay on, contact your EPSON dealer or see Where To 
Get Help.

Possible cause Solution

The ink cartridge 
clamp isn’t locked.

Press down the clamp to lock it.

Packing material 
remains in the printer.

Remove the tape and other packing material following the instructions on 
the unpacking sheet.

The printer needs to 
initialize.

If the printer is not moving or making noise, but the 

 

P power light is still 
flashing after more than 5 minutes, turn the printer off. If the light is still 
flashing when you turn it back on, contact your EPSON dealer or see 
Where To Get Help.
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If you have trouble with your printer software, first check that your printer 
is selected as the Windows default printer or as the current printer in the 
Macintosh Chooser. If you still have problems with your printer software, 
check these solutions:

The printer software you installed with Windows 95 doesn’t work correctly after you 
upgrade to Windows 98

While installing your printer software, you see the New Hardware Found window

Possible cause Solution

Your printer software 
isn’t set up correctly for 
Windows 98.

Uninstall the printer software after installing Windows 98, as described in 
the Printer Basics book. Then reinstall it as described in the Start Here 
card.

Possible cause Solution

Windows has detected 
your printer.

If you connected your printer using the parallel port, click Cancel . Never 
select any other option on the New Hardware Found window.

If you connected your printer using the USB port, see the Start Here 
card for software installation instructions using Windows plug-and-play.
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You see a spooling error message (Windows)

You see a memory error message (Macintosh)

In Windows, the Status Monitor 2 window doesn’t appear

Possible cause Solution

Your hard drive is full. Delete unnecessary files to make room for print job files on the drive.

Your computer doesn’t 
have enough memory 
to print your file.

Try the following:
◗ Close any open applications, including screen savers and virus scan

programs.
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your display or monitor.
◗ Add more memory to your computer.

Possible cause Solution

You need to increase 
the memory allocated 
for your application, 
EPSON Monitor3, or 
both.

Choose Get Info  from the File menu when the application is active or 
when EPSON Monitor3 is selected and increase the memory allocation. 
See Using Monitor3 for more information. 

If that doesn’t work, turn off background printing in the Chooser or in your 
printer software; see Using Background Printing on the Macintosh for 
instructions. (You won’t be able to use Monitor3.)

Possible cause Solution

You didn’t restart your 
computer after 
installing Status 
Monitor 2.

Click Start , select Shut Down , click Restart the computer , and click 
Yes to restart your computer. Then try using Status Monitor 2. 
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Printing is too slow

Bidirectional support is 
not enabled.

Click Start , select Settings , and click Printers . Right-click the EPSON 
Stylus Photo 1200  icon and select Properties . Click the Details  tab, 
then click the Spool Settings  button. Click the Enable bi-directional 
support for this printer  radio button to turn on bidirectional support. 
Click OK twice, then close the Printers window and try printing again.

You’re using 
ScanDisk.

Before using ScanDisk, turn off background monitoring in Status 
Monitor 2. (See Turning on Background Monitoring for instructions.) 
Then turn it back on when you’re finished using ScanDisk.

Possible cause Solution

Your printer software 
options are set 
incorrectly.

For the fastest printing, try the following printer software settings:
◗ Set Print Quality to Economy
◗ Turn MicroWeave off
◗ Turn High Speed on
◗ Choose Black ink
See Custom Printing for instructions.

Your system doesn’t 
have enough 
resources.

◗ Clear space on your hard disk or run a defragmentation utility.
◗ Don’t run too many applications at the same time.
◗ Turn off virtual memory.
◗ Increase your system’s memory (RAM) and/or processor speed.

Possible cause Solution
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Your printer switches to the modem port or won’t confirm on the printer 
port (Macintosh)

You’re using 
background printing 
on a Macintosh.

You need to increase the memory allocated for your application, EPSON 
Monitor3, or both. Choose Get Info  from the File menu when the 
application is active or when EPSON Monitor3 is selected and increase 
the memory allocation. See Using Monitor3 for more information. 

If that doesn’t work, turn off background printing in the Chooser or in 
your printer software; see Using Background Printing on the Macintosh 
for instructions. (You won’t be able to use Monitor3.)

You’re not using ECP 
or Enhanced mode 
and/or DMA transfers.

If your computer supports ECP or Enhanced mode and/or DMA 
transfers, turn them on to speed up printing. See your computer 
documentation for details.

Possible cause Solution

Your Macintosh has 
extension conflicts.

Make sure AppleTalk® is inactive. In the Chooser, select any Apple serial 
printer (such as the LaserWriter) and choose the printer port. Close the 
Chooser, then reopen it and select the SP 1200 icon and the printer port. 
Then restart your system.

You’re using an 
AppleTalk cable.

Make sure you’re using a LaserWriter II serial cable. See Macintosh 
System Requirements for more information.

Possible cause Solution
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Your printer icon doesn’t appear in the Chooser (Macintosh)

Your application program can’t open your image file (Macintosh)

The “SP 1200 cannot be used” message appears (Macintosh )

Your printer doesn’t print correctly as a remote printer (Windows NT)

Possible cause Solution

Your Macintosh has 
extension conflicts.

Disable Quick Draw® GX in the Extensions Manager. Make sure EPSON 
Monitor3 and SP 1200 are enabled, and then restart your Macintosh.

The Chooser contains 
too many items.

Delete unused items or move them to the Extensions (Disabled) folder. 
Then check for your printer icon in the Chooser again.

Possible cause Solution

Not enough memory 
is allocated to the 
application.

Highlight the program icon and select Get Info  from the File menu, then 
increase the memory allocated to the application.

Possible cause Solutions

The printer software 
has been corrupted.

Remove and reinstall the printer software as described in the Printer 
Basics book. Then, in the Extensions Manager, disable Quick Draw GX, 
enable EPSON Monitor3 and SP 1200, and restart.

Possible cause Solution

You may need to use 
a different network 
path and printer port.

Select a different printer port in the printer’s Properties window and enter 
the new network path to your printer at the DOS prompt. Then restart 
your computer. See your Windows NT documentation for instructions on 
changing the printer port and network path.
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To avoid most paper handling problems:

◗ Use smooth, high-quality media designed for ink jet printers that meets 
the media specifications in Paper.

◗ Follow all loading and handling instructions included with the media.

◗ Load the media with the printable side face up as described in the Start 
Here card and in Paper Loading and Handling Guidelines.

If you have any paper problems, check the following tables for solutions.

Paper doesn’t feed

Try this Then do this

Remove the stack of 
paper from the printer.

Check that the paper isn’t:

◗ Curled or creased.
◗ Too old. (See Paper Loading and Handling Guidelines or your 

paper packaging for more information.)
◗ Loaded above the arrow on the left edge guide.
◗ Jammed inside the printer. (If the 

 

S paper out light is flashing, 
paper is jammed.)

Then reload the paper against the right edge guide and adjust the left 
edge guide to fit the paper’s width, as described in the Start Here card 
and in Paper Loading and Handling Guidelines. 
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Multiple pages feed at the same time

Paper jams inside the printer

Try this Then do this

Remove the stack of 
paper from the printer.

◗ Make sure the paper isn’t too thin (see the specifications in Paper).
◗ Fan all the edges of the stack of paper to separate the sheets.
◗ Reload the paper as described in the Start Here card and in Paper 

Loading and Handling Guidelines.
◗ Make sure the paper thickness lever is set to the 0 position if you’re 

printing on normal paper.
◗ If too many copies of a page or document are printing, check the 

Copies settings in both the printer software and your application 
program. See Selecting Paper Size and Orientation Options for 
more information.

Try this Then do this

Turn off your printer, 
open the cover, and 
remove all the paper 
that’s inside, including 
any little pieces that 
may have torn off. 

Load more paper in the printer, following the instructions in the Start 
Here card and in Paper Loading and Handling Guidelines. If your paper 
jams frequently, make sure you:

◗ Use smooth, high-quality paper, loaded printable side up.
◗ Fan the stack and then even the edges before loading it.
◗ Load paper beneath the arrow mark on the left edge guide.
◗ Adjust the left edge guide to fit the width of your paper.
◗ Make sure the paper thickness lever is set to the correct setting for 

the thickness of your paper.
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Paper doesn’t eject fully or is wrinkled
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If your printout results are not what you expected, try these solutions.

Characters are incorrect or garbled

Possible cause Solution

If the paper doesn’t 
eject fully, you may 
have set the wrong 
paper size.

Press the 

 

E load/eject button to eject the paper. Then make sure you 
select the correct paper size in your printer software. See Selecting 
Paper Size and Orientation Options for instructions.

If it’s wrinkled when it 
comes out, the paper 
may be damp or too 
thin.

See the specifications in Paper for ranges of paper thicknesses you can 
print with, as well as environmental requirements for storage.

Possible cause Solution

Your printer isn’t 
selected in your 
application or as the 
Windows default 
printer.

Select your printer in your application or select it as the Windows default 
printer. See your Windows documentation or online help for 
instructions.

Your printer is not 
selected in the 
Macintosh Chooser.

Select your printer in the Chooser as described in the Start Here card.
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The image is inverted as if viewed in a mirror

Printing is stalled. In Windows, delete the stalled print jobs in Spool Manager; see Using 
the Spool Manager for instructions. In Windows NT, uninstall the 
EPSON Printer Port. Click Start , point to Programs , EPSON Printers , 
and select EPSON Printer Port Uninstall .

On a Macintosh, select the stalled print jobs in Monitor3 (see Using 
Monitor3) or open the Extensions folder, EPSON folder, and Spool 
folder, and delete any queued files.

The interface cable is 
loose.

Turn off your printer and computer, then connect the cable securely. 
Make sure the cable meets the printer’s specifications, as described in 
Windows System Requirements and Macintosh System Requirements.

Your video driver may 
be conflicting with the 
EPSON printer driver.

Change to a standard VGA driver (see your computer or video card 
documentation for instructions) and try printing again. If your printout is 
correct, your video driver is interfering with the printer driver. Contact 
your computer or video card manufacturer for an updated driver.

Possible cause Solution

You used a Flip 
Horizontal option.

Turn off the Flip Horizontal or mirror setting in your application software 
or the printer software. See Customizing Print Quality and Special 
Effects for instructions.

Possible cause Solution
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The image size or position is incorrect

The margins are incorrect

A portion of your image doesn’t print (Macintosh)

Possible cause Solution

The paper and/or 
layout options are set 
incorrectly.

Check the paper settings and layout options. See Selecting Paper Size 
and Orientation Options and Selecting Print Layout Options for 
instructions. Also check the paper and layout options in your application 
software.

Possible cause Solution

Margins are set 
incorrectly in your 
application software.

Check your software documentation for instructions on selecting the 
correct margins for your paper size and within its printable area. See 
Printable area for more information.

Paper settings in the 
printer software are 
incorrect for your paper 
size.

Check the paper size, orientation, printable area, and layout settings to 
make sure they’re correct for your paper size. See Selecting Paper Size 
and Orientation Options and Selecting Print Layout Options for more 
information.

Possible cause Solution

Your system doesn’t 
have enough available 
memory.

Close any other applications you are running and turn off background 
printing as described in Using Background Printing on the Macintosh.
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The printer prints blank pages

You need to increase 
the memory allocated 
for your application, 
EPSON Monitor3, or 
both.

Choose Get Info  from the File menu when the application is active or 
EPSON Monitor3 is selected and increase the memory allocation. See 
Using Monitor3 for more information. 

If that doesn’t work, turn off background printing in the Chooser or in 
your printer software; see Using Background Printing on the Macintosh 
for instructions. (You won’t be able to use Monitor3.)

Possible cause Solution

Your printer isn’t 
selected in your 
application or as the 
Windows default 
printer.

Select your printer in your application or select it as the Windows default 
printer. See your Windows documentation or online help for instructions.

Your printer is not 
selected in the 
Macintosh Chooser.

Select your printer in the Chooser as described in the Start Here card.

Paper settings in the 
printer software are 
incorrect for your 
paper size.

Check the paper size, orientation, printable area, and layout settings to 
make sure they’re correct for your paper size. See Selecting Paper Size 
and Orientation Options and Selecting Print Layout Options for more 
information.

The print head nozzles 
are clogged.

Clean the print head following the instructions in Cleaning the Print 
Head.

Possible cause Solution
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EPSON provides technical assistance through electronic support services 
and automated telephone services 24 hours a day. The following tables 
list the contact information:

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com .

EPSON Internet FTP Site If you have Internet FTP capability, use your Web browser 
(or other software for FTP downloading) to log onto 
ftp.epson.com  with the user name anonymous  and your 
e-mail address as the password.

EPSON Forum on CompuServe® Members of CompuServe can type GO EPSON at the menu 
prompt to reach the Epson America Forum. For a free 
introductory CompuServe membership, call (800) 848-8199 
and ask for representative #529.
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To speak to a technical support representative, dial the following (toll or 
long distance charges may apply):

◗ U.S.: (310) 533-4018, 6 AM to 8 PM, Pacific Time, Monday through 
Friday and 7 AM to 4 PM, Saturday

◗ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through 
Friday and 7 AM to 4 PM, Saturday

Before you call, please have the following information ready:

◗ Product name and serial number (located on the back of the printer)

◗ Computer configuration

◗ Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from 
EPSON Accessories at (800) 873-7766 (U.S. sales only). Or visit our web 
site at www.epsonsupplies.com (U.S. sales only). In Canada, please call 
(800) 873-7766 for dealer referral.

Automated telephone services

Service Access

EPSON SoundAdvice For pre-recorded answers to commonly asked questions 
about EPSON products 24 hours a day, seven days a week, 
call (800) 922-8911.

EPSON FaxAdvice™ Access EPSON’s technical information library by calling 
(800) 922-8911. You must provide a return fax number to 
use this service.

EPSON Referral Service For the location of your nearest Authorized EPSON Reseller 
or Customer Care Center, call (800) 922-8911.

SM

If you need help 
using another 
manufacturer’s 
software with an 
EPSON product, see 
the documentation 
for that software for 
technical support 
information.
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Printing method On-demand ink jet

Nozzle configuration 48 black nozzles 
240 color nozzles (48 each of cyan, magenta, yellow, light cyan, and 
light magenta)

Resolution Maximum 1440 × 720 dpi

Input buffer 128KB

Print direction Bidirectional with logic seeking

Control code ESC/P Raster™ and EPSON Remote
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Paper Size Types Thickness Weight

Single sheets Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B (11 × 17 inches)
B5 (182 × 257 mm)
Super B/A3 (13 × 19 inches)
Legal (8.5 × 14 inches) 
Half letter (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)

Plain paper and 
special ink jet 
papers 
distributed by 
EPSON

0.003 to 0.004 inch 
(0.08 to 0.11 mm) 

17 to 24 lb 
(64 to 90 g/m2) 

Transparencies Letter (8.5 × 11 inches)
A4 (210 × 297 mm)

Transparencies 
distributed by 
EPSON

— —

Glossy film Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm)
B (11 × 17 inches)
Super B/A3 (13 × 19 inches)

Glossy film 
distributed by 
EPSON

— —

Photo paper 4 × 6 inches (102 × 152 mm)
Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
B (11 × 17 inches)
Super B/A3 (13 × 19 inches)
Panoramic (8.27 × 23.4 inches)
Banner (13 inches × 32.8 feet)

Photo paper 
distributed by 
EPSON

— —
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Photo stickers A6 (105 × 148 mm)
with 16 frames

Photo stickers 
distributed by 
EPSON

— —

Self adhesive 
sheets and 
iron-on cool peel 
transfer paper 

A4 (210 × 297 mm)
Letter (8.5 × 11 inches; iron-on

cool peel transfer paper 
only)

Self adhesive 
sheets and cool 
peel iron-on 
transfer paper 
distributed by 
EPSON

— —

Envelopes #10 9.5 × 4.1 inches 
(240 × 104 mm) 

DL 8.7 × 4.3 inches 
(220 × 110 mm) 

C6 4.4 × 6.4 inches 
(114 × 162 mm)

Note card envelope
5.2 × 8.7 inches
(132 × 220 mm)

Plain, bond, or 
air mail paper

0.006 to 0.02 inch 
(0.16 to 0.52 mm)

12 to 20 lb 
(45 to 75 g/m2)

Cards A6 (105 × 148 mm)
8 × 10 inches (203 × 254 mm)

Ink jet cards 
distributed by 
EPSON

— —

Ink jet back light 
film

A3 (11.7 × 16.5 inches) Ink jet back light 
film distributed 
by EPSON

— —

Paper Size Types Thickness Weight
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Print only under these conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

Store glossy film and self adhesive sheets under these conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Since the quality of any particular brand or type of paper may be changed by the 
manufacturer at any time, EPSON cannot guarantee the use of any particular 
brand or type of paper. Always test samples of paper stock before purchasing 
large quantities or printing large jobs. 

Poor quality paper may reduce print quality and cause paper jams and other 
problems. If you encounter problems, switch to a higher grade of paper. Do not 
load curled or folded paper, envelopes, or transparencies.
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Printable area

A The minimum top margin is 0.12 inch (3 mm).
When printing on multiple sheets of EPSON Photo Quality Glossy Film,
the minimum top margin is 1.2 inches (30 mm).

BL The minimum left margin is 0.12 inch (3 mm).

BR The minimum right margin is:
0.35 inch (9 mm) for Letter and Legal size paper
1.10 inches (28 mm) for #10 envelopes
0.28 inch (7 mm) for DL envelopes
0.12 inch (3 mm) for all other paper sizes.

C The minimum bottom margin is 0.55 inch (14 mm) using the Standard
printable area setting. This can be decreased to 0.12 inch (3 mm)
using the Maximum printable area setting. However, the print quality in
the expanded printable area may be reduced.

A

B-L B-R

C

A

B-R
C

B-L

Envelopes

Single sheets and cards

A

B-L

B-R

C

EPSON Panoramic 
Photo Paper 

C

Always load paper 
into the sheet feeder 
short edge first, 
except envelopes; 
load envelopes long 
edge first.



�����%������� ���� �	�

!�+ �������#��

* The print capacity may vary depending on how often you clean the print head.

** The ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

To ensure good results, use genuine EPSON cartridges and do not refill them. Other products may 
cause damage to your printer not covered by EPSON’s warranty.

Do not use an ink cartridge after the expiration date on the package.

Specification Black ink cartridge (S020187) Color ink cartridge (T001011)

Color(s) Black Cyan, magenta, yellow, light cyan, 
light magenta

Print 
capacity*

540 pages (ISO/IEC 10561 letter pattern at 
360 dpi)

330 pages (15% coverage at 360 
dpi)

Cartridge life 2 years from production date and within 6 months of opening package 
at 77 °C (25 °F)

Storage 
temperature

–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit 
temperature

–22 to 140 °F (–30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing 
temperature**

3.2 °F (–16 °C) –0.4 °F (–18 °C)

Dimensions 0.78 (W) × 2.1 (D) × 1.5 (H) inches
19.8 (W) × 52.7 (D) × 38.5 (H) mm

1.7 (W) × 2.1(D) × 1.5 (H) inches
42.9 (W) × 52.7 (D) × 38.5 (H) mm
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Paper feed method Friction with auto sheet feeder, rear entry

Sheet feeder 
capacity

Maximum 100 sheets of 17 lb (64 g/m2) paper

Dimensions

Storage Width: 22.8 inches (578 mm) 
Depth: 10.3 inches (262 mm) 
Height: 6.9 inches (174 mm)

Printing Width: 22.8 inches (578 mm) 
Depth: 28.0 inches (711 mm), fully open
Height: 12.2 inches (311 mm)

Weight 15 lb (7 kg) without the ink cartridges

��)���������

Temperature Operation 50 to 95 °F (10 to 35 °C)
Storage*  –4 to 104 °F (–20 to 40 °C)

1 month at 104 °F (40 °C)
Transit* –4 to 140 °F (–20 to 60 °C)

120 hours at 140 °F (60 °C)

Humidity Operation 20 to 80% RH
Storage* 5 to 85% RH (without condensation)

* Stored in shipping container
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* Also designed for IT power systems with Phase to Phase voltage 220–240V
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Safety standards UL 1950, CSA 22.2 No. 950

EMC FCC part 15 subpart B class B

Specification 120V model 240V model*

Input voltage range 99V to 132V 198V to 264V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4A 0.2A

Power consumption Approx. 18 W (ISO 10561 Letter Pattern)
Approx. 5 W in standby mode
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Parallel interface Forward channel

Specification Description

Data format 8-bit parallel, IEEE-1284 compatibility mode

Synchronization STROBE pulse

Handshake timing BUSY and ACKNLG signals

Signal level TTL compatible

Connector 57-30360 Amphenol connector or equivalent

Reverse channel

Specification Description

Transmission mode IEEE-1284 Nibble mode

Adaptable connector 57-30360 Amphenol connector or equivalent

Synchronization Refer to the IEEE-1284 specification

Handshaking Refer to the IEEE-1284 specification

Signal level IEEE-1284 Level 1 device

Data transmission 
timing

Refer to the IEEE-1284 specification
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Serial interface

USB interface

Specification Description

Standard Based on RS-423

Synchronization Synchronous

Bit rate Approximately 1.8 Mbps

Handshaking X-ON/X-OFF and DTR protocol

Word format Data bit: 8 bits
Parity bit: None
Start bit: 1 bit
Stop bit: 1 bit

Connector 8-pin mini-DIN

Recommended 
cable

ImageWriter II serial cable (preferably Belkin 
brand)

Specification Description

Standard Based on Universal Serial Bus Specifications 
Revision 1.0, Universal Serial Bus Device Class 
Definition for Printing Devices Version 1.0

Bit rate 12 Mbps (full speed device)

Data encoding NRZI

Adaptable 
connector

USB Series B

Recommended 
cable length

6.5 feet (2 meters) or less
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Accessories, 73, 112, 151
Aligning print heads, 120, 130
Automatic mode, 20, 25

�
Background printing

Macintosh, 25 to 26, 67 to 68, 
103 to 106

Windows, 90 to 100
Banding, 129 to 130
Banner Photo Paper, see Photo Paper
Banner printing, 43, 48, 80
Basic printing, 17 to 26
Bitmap files, 56 to 58
Blank pages, 149
Blurry printouts, 133 to 134
Brightness setting, 37

�
Cards, see Photo Quality Ink Jet Cards
Characters, garbled, 146 to 147
Checking printer, 126

Cleaning print head, 116 to 118
Cleaning printer, 121
Cleaning sheets, 74
Collate setting, 44, 50
Color Adjustment modes, 37
Color problems, 130 to 132
Color settings, customizing, 34 to 41
ColorSync, using, 30, 39 to 41
Configuration options, Macintosh, 

109 to 110
Contrast setting, 37
Control code, 152
Control panel, using, 118, 125 to 126
Custom printing, 27 to 70
Custom settings

color, 34 to 41
deleting, 70
layout, 51 to 64
orientation, 41 to 45, 47 to 48
paper size, 41 to 50
print quality, 31 to 34
project types, 28 to 30
revising, 70
saving, 68 to 70
special effects, 31 to 34

Cyan setting, 37
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Data transfer, optimizing, 101 to 102
Default printer options, setting, 21
Diagnosing problems, 124 to 127
Diffusion, error, 33
Digital Camera setting, 29, 34 to 35
Dithering, 33
DMA transfers, 101 to 102, 142

�
Economy setting, 29, 32
Electrical specifications, 159
Energy Star, 13
Envelopes

loading, 77
specifications, 154 to 156

Environmental specifications, 158
EPSON

Accessories, 73, 112, 151
help, 150 to 151
papers, 71 to 83
printer port, 101 to 102, 136, 147
Remote, 152

EPSON Spool Manager, see Spool 
Manager

Error Diffusion setting, 33
Error notification, 90 to 98, 109 to 110
ESC/P Raster control code, 152

�
Faint printouts, 132
Film, see Photo Quality Glossy Film
Fine Dithering, 33
Finest Detail setting, 33
Fit to Page setting, 54, 59 to 61
Flip Horizontal setting, 33, 82, 147
Forms, loading, 75

�
Garbled characters, 147
Glossy Film, see Photo Quality Glossy Film
Graph setting, 29, 36

�
Halftoning setting, 33, 131
Head Cleaning utility, 117
Help, 150 to 151
High Speed copies, 101 to 102, 109 to 110
High Speed setting, 33, 128, 130
Horizontal banding, 129

	
ICM (Image Color Matching) setting, 29, 

38 to 39
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Ink
cartridge specifications, 157
monitoring level, 98, 107 to 108
replacing cartridges, 111 to 116
replacing outdated cartridge, 

114 to 116
setting, 20, 25, 28, 32, 130
specifications, 157

Ink Jet Back Light Film
choosing, 19, 24, 72 to 73
loading, 74, 83
specifications, 154 to 156

Ink Jet Cards, see Photo Quality Ink Jet 
Cards

Ink Jet Paper
choosing, 19, 24, 72 to 73
loading, 74
specifications, 153 to 156

Ink Jet Transparencies, see 
Transparencies

Interface specifications, 160 to 161
Introduction, 8 to 16
Iron-On Cool Peel Transfer Paper

choosing, 72 to 73
loading, 74, 82
specifications, 154 to 156



Jammed paper, 125, 145

�
Landscape setting, 44, 48
Layout

icon, 25, 50, 60
options, setting, 51 to 64
problems, 148
tab, 20, 53

Letterhead, loading, 75
Lights, using, 125 to 126

�
Macintosh

background printing, 25 to 26, 
67 to 68, 103 to 106

ColorSync, 30, 39 to 41
configuration options, 109 to 110
increasing memory allocation, 

103 to 104
managing print jobs, 103 to 106, 

109 to 110
Monitor3, 26, 103 to 106
previewing, 25, 65 to 66
printing from, 23 to 26
problems printing, 139 to 143
Status Monitor, 107 to 108
system requirements, 10

Magenta setting, 37
Main tab, 19
Maintaining printer, 111 to 121
Manuals, how to use, 12 to 13
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Margin
problems, 148
specifications, 156
with multiple sheets, 75

Mechanical specifications, 158
Media Type setting, 19 to 20, 24, 28, 32, 

72 to 73, 128
Memory allocation, increasing on 

Macintosh, 103 to 104
MicroWeave setting, 33, 129
Monitor3, 26, 103 to 106
Monitoring

ink level, 98, 107 to 108
print jobs, see Background printing

Moving printer, 122
Multiple page feeding, 145
Multiple print layouts, 55, 64


Nozzle Check, 117 to 119

�
Optimizing data transfer, 101 to 102
Orientation options, 41 to 45, 47 to 48
Outdated ink cartridge, 114 to 116

�
Packing printer, 122
Page frames, 55, 64
Page Order options, 55, 64
Page Setup dialog box, 23, 47
Panoramic Photo Paper, see Photo Paper
Paper

choosing, 72 to 73
handling problems, 144 to 146
loading, 74 to 83
specifications, 153 to 156

Paper jams, 125, 145
Paper Size options, 41 to 50
Paper support, 75, 80, 83
Paper tab, 20, 42
Paper thickness lever, 77, 79, 81, 

129 to 130, 133
Parallel interface specifications, 160
Photo Paper

choosing, 19, 24, 72 to 73
loading, 74, 78 to 80
specifications, 153 to 156

Photo Quality Glossy Film
choosing, 19, 24, 72 to 73
loading, 74 to 76
specifications, 153 to 156

Photo Quality Ink Jet Cards
choosing, 72 to 73
loading, 74, 81
specifications, 154 to 156
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Photo Quality Ink Jet Paper
choosing, 19, 24, 72 to 73
loading, 74
specifications, 153 to 156

Photo Quality Self Adhesive Sheets
choosing, 72 to 73
loading, 74, 82
specifications, 154 to 156

Photo Stickers
choosing, 72 to 73
loading, 74, 81
specifications, 154

PhotoEnhance3 setting, 29, 34 to 35
PICT files, 61 to 62
Plain paper, 19, 24, 153 to 156
Portrait setting, 44, 48
Preprinted forms, loading, 75
Previewing, Macintosh, 25, 65 to 66
Print dialog box, 18
Print Head Alignment utility, 120, 130
Print head, cleaning, 116 to 118
Print jobs

managing in Windows, 85 to 102
managing on Macintosh, 103 to 106, 

109 to 110
Print layouts, multiple, 55, 64
Print Order options, 50 to 51
Print quality

customizing, 31 to 34
problems, 128 to 134
specifications, 152

Print time, setting, 67 to 68, 105 to 106
Printable area

setting, 45, 48, 76, 129
specifications, 156

Printer check, 126
Printer ID, checking, 127
Printer parts, 11
Printer port, EPSON, 101 to 102, 136, 147
Printer software

problems, 139 to 143
settings, see Settings, printer software

Printer, cleaning, 121
Problems

diagnosing, 124 to 127
paper handling, 144 to 146
print quality, 128 to 134
printer software, 139 to 143
printing, 135 to 138
solving, 123 to 149
unexpected printout results, 146 to 149

Progress Meter
dialog box, 22, 86
Speed & Progress options, 85 to 88, 

101 to 102
Project types, custom, 28 to 30

�
Quality/Speed slider, 20, 25
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ReadMe files, 124
Reduce/Enlarge setting, 43, 52 to 54
Rendering Intent setting, 41
Replacing ink cartridges, 111 to 116
Resolution, see Print quality
Reverse Order setting, 44, 51
Rotate by 180° setting, 44, 48

�
Safety approvals, 159
Safety instructions, 14 to 16
Saturation setting, 37, 41
Self Adhesive Sheets, see Photo Quality 

Self Adhesive Sheets
Serial interface specifications, 10, 161
Service, 150 to 151
Settings, printer software

basic, 18 to 20, 23 to 25
custom, see Custom settings
default, 21
reusing on Macintosh, 23

Sharpness setting, 35

Smears, 133 to 134
Special effects, 31 to 34
Specifications

electrical, 159
environmental, 158
ink cartridges, 157
interface, 160 to 161
mechanical, 158
paper, 153 to 156
printing, 152
safety approvals, 159

Speed & Progress options, 85 to 88, 
101 to 102

Spool folders, 109 to 110
Spool Manager

problems, 136, 147
using, 89

sRGB (standard Red Green Blue) setting, 
30, 38 to 39

Status Monitor
Macintosh, 107 to 108
problems, 124, 140
Windows, 90 to 100

Support, 150 to 151
System requirements, 9 to 10
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Technical specifications, 152 to 161
Text setting, 29, 36
Text/Graph setting, 29, 36
Thickness lever, 77, 79, 81, 129 to 130, 

133
Tone setting, 35
Transparencies

choosing, 19, 24, 72 to 73
loading, 74 to 76
specifications, 153 to 156

Transporting printer, 122
Troubleshooting, 123 to 151

�
USB interface specifications, 9 to 10, 161
User Defined paper size, 45 to 46, 49 to 50
Utility dialog box, 87, 101, 107, 117 to 118, 

120

�
Vertical banding, 130

�
Watermarks, 56 to 58, 61 to 63
Windows

background printing, 90 to 100
default options, setting, 21
managing print jobs, 85 to 102
printer status, checking, 22, 85 to 100
printing from, 17 to 22
problems printing, 139 to 143
Status Monitor 2, 90 to 100
system requirements, 9

�
Year 2000, 14
Yellow setting, 37
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